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LIMITED WARRANTY AND LIMITATION OF LIABILITY
Horner APG, LLC, ("HE-APG") warrants to the original purchaser that the CPU200 and CPU250 modules manufactured by HE-APG
is free from defects in material and workmanship under normal use and service. The obligation of HE-APG under this warranty shall
be limited to the repair or exchange of any part or parts which may prove defective under normal use and service within two (2) years
from the date of manufacture or eighteen (18) months from the date of installation by the original purchaser whichever occurs first,
such defect to be disclosed to the satisfaction of HE-APG after examination by HE-APG of the allegedly defective part or parts.
THISWARRANTY IS EXPRESSLY IN LIEU OF ALL OTHERWARRANTIES EXPRESSED OR IMPLIED INCLUDING THE
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE AND OF ALL OTHER OBLIGATIONS OR LIABILITIES AND
HE-APG NEITHER ASSUMES, NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR HE-APG, ANY OTHER LIABILITY
IN CONNECTIONWITH THE SALE OF THESE CPU200 AND CPU250 MODULES. THISWARRANTY SHALL NOT APPLY TO
THIS MODULE OR ANY PART THEREOFWHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE, ALTERATION, ABUSE,
ORMISUSE. HE-APGMAKES NOWARRANTYWHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED
BY HE-APG. THE TERM "ORIGINAL PURCHASER", AS USED IN THISWARRANTY, SHALL BE DEEMED TOMEAN THAT
PERSON FORWHOM THE CPU200 AND/OR 250 MODULES ARE ORIGINALLY INSTALLED. THISWARRANTY SHALL APPLY
ONLYWITHIN THE BOUNDARIES OF THE CONTINENTAL UNITED STATES.
In no event, whether as a result of breach of contract, warranty, tort (including negligence) or otherwise, shall HE-APG or its
suppliers be liable of any special, consequential, incidental or penal damages including, but not limited to, loss of profit or revenues,
loss of use of the products or any associated equipment, damage to associated equipment, cost of capital, cost of substitute
products, facilities, services or replacement power, down time costs, or claims of original purchaser's customers for such damages.
To obtain warranty service, return the product to your distributor with a description of the problem, proof of purchase, postpaid,
insured, and in a suitable package.
ABOUT PROGRAMMING EXAMPLE
Any example programs and program segments in this manual or provided from Horner's website, Cscape, or on YouTube, are
included solely for illustrative purposes. Due to the many variables and requirements associated with any installation, Horner APG
cannot assume responsibility or liability for actual use based on the examples and diagrams. It is the sole responsibility of the
system designer utilizing the CPU200 and CPU250 modules to design the end system, integrate the CPU200 and CPU250
modules, and make safety provisions for the end equipment customary to industrial applications as defined in any codes or
standards which apply.

NOTE: The programming examples shown in this manual are for illustrative purposes only. Proper machine operation is the sole
responsibility of the system integrator.
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PREFACE
This manual explains how to use the CPU200 OCS and CPU250 OCS.
Copyright© 2025 Horner APG, LLC, 59 South State Avenue, Indianapolis, Indiana 46201. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or computer
language, in any form by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without the prior
agreement and written permission of Horner APG, Inc.
All software described in this document or media is also copyrighted material subject to the terms and conditions of the Horner
Software License Agreement.
Information in this document is subject to change without notice and does not represent a commitment on the part of Horner APG.
Ethernet™ is a trademark of Xerox Corporation.
microSD™ and CompactFlash are registered trademarks of SanDisk Corporation.
Cscape, SmartStack, SmartStix, SmartRail, and CsCAN are trademarks of Horner APG.
microSD® and CompactFlash are registered trademarks of SanDisk Corporation®.

Published with Madcap Flare®.

North America
Tel: (+) (317) 916-4274
Fax: (+) (317) 639-4279
Web: http://www.hornerautomation.com
Email: APGUSATechSupport@heapg.com

Europe
Tel: (+) 353-21-4321-266
Fax: (+) 353-21-4321-826
Web: http://hornerautomation.eu
Email: technical.support@horner-apg.com

http://www.hornerautomation.com/
mailto:techsppt@heapg.com
http://www.hornerautomation.com/
mailto:technical.support@horner-apg.com
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Chapter 1: Safety and Compliance

Chapter 1: Safety and Compliance
1.1: Warnings
When found on the product, the following symbols specify:

WARNING: Consult user documentation.

WARNING: Electrical Shock Hazard.

WARNING: EXPLOSION HAZARD – Substitution of components may impair suitability for Class I, Division 2.

WARNING: EXPLOSION HAZARD – Do not disconnect equipment unless power has been switched off or the area is
known to be non-hazardous.

1. To avoid the risk of electric shock or burns, always connect the safety (or earth) ground before making any other
connections.

2. To reduce the risk of fire, electrical shock, or physical injury it is strongly recommended to fuse the voltage
measurement inputs. Be sure to locate fuses as close to the source as possible.

3. Replace fuse with the same type and rating to provide protection against risk of fire and shock hazards.
4. In the event of repeated failure, do not replace the fuse again as a repeated failure indicates a defective condition that

will not clear by replacing the fuse.
5. Only qualified electrical personnel familiar with the construction and operation of this equipment and the hazards

involved should install, adjust, operate, or service this equipment. Read and understand this manual and other
applicable manuals in their entirety before proceeding. Failure to observe this precaution could result in severe bodily
injury or loss of life.

WARNING: BATTERYMAY EXPLODE IF MISTREATED. DO NOT RECHARGE, DISASSEMBLE, OR DISPOSE OF IN
FIRE.

WARNING: BATTERIES MUST ONLY BE CHANGED IN AN AREA KNOWN TO BE NON-HAZARDOUS.

WARNING: The USB parts are for operational maintenance only. Do not leave permanently connected unless area is
known to be non-hazardous.

WARNING: If the equipment is used in a manner not specified by Horner APG, the protection provided by the equipment
may be impaired.

NOTE: All applicable codes and standards must be followed in the installation of this product.
NOTE: For I/O wiring (discrete), use the following wire type or equivalent: Belden 9918, 18 AWG, or larger.
NOTE: See Electrical Installation for more details.
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Chapter 1: Safety and Compliance

1.2: FCC Compliance
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference.
2. This device must accept any interference received, including interference that may cause undesired operation.

1.3: Safety Precautions
All applicable codes and standards need to be followed in the installation of this product.
Adhere to the following safety precautions whenever any type of connection is made to the module:

1. Connect the safety (earth) ground on the power connector first before making any other connections.
2. When connecting to the electric circuits or pulse-initiating equipment, open their related breakers.
3. Do NOTmake connection to live power lines.
4. Make connections to the module first; then connect to the circuit to be monitored.
5. Route power wires in a safe manner in accordance with good practice and local codes.
6. Wear correct personal protective equipment including safety glasses and insulated gloves when making connections

to power circuits.
7. Ensure hands, shoes, and floor are dry before making any connection to a power line.
8. Make sure the unit is turned OFF before making connection to terminals.
9. Make sure all circuits are de-energized before making connections.
10. Before each use, inspect all cables for breaks or cracks in the insulation. Replace immediately if defective.
11. Use copper conductors in Field Wiring only, 60/75°C.
12. Use caution when connecting controllers to PCs via serial or USB. PCs, especially laptops may use “floating power

supplies” that are ungrounded. This could cause a damaging voltage potential between the laptop and controller.
Ensure the controller and laptop are grounded for maximum protection. Consider using a USB isolator due to voltage
potential differences as a preventative measure.
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Chapter 2: Intro to the CPU200/250

Chapter 2: Intro to the CPU200/250

2.1: Where To Find More Information On The CPU200/250 4
2.2: Visual Overview 4
2.3: Connectivity to the CPU200/250 5
2.4: Features of CPU200/250 6

2.1: Where To Find More Information On The CPU200/250
Datasheet - The datasheet is the first documents to refer to for key information related to specific models. (A basic datasheet is
provided in the box with the unit.) . FindMAN1138 via the Documentation Search page on the Horner website.

2.2: Visual Overview

NOTE: CPU200 has no built-in I/O and CPU250 has built-in I/O. Mentions of I/O in this user manual apply only to CPU250.

1. Power Input
2. Digital & Flexible In (CPU250 Only)
3. Digital Out & Analog Out (CPU250 Only)
4. MJ1/2 Serial Port
5. Ethernet Port

6. microSD Port
7. Status LEDs
8. Mode Switch
9. CAN Port
10. USB Type C Port
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Chapter 2: Intro to the CPU200/250

2.3: Connectivity to the CPU200/250

NOTE: For the CPU200 use OCS I/O or Remote I/O.

Connectivity
CAN I/O USB Serial Ethernet

Other OCS Devices Sensors Cscape Other OCS Devices Cscape

SmartStix I/O Indicators Drives OPC Server

SmartBlock I/O Alarms PLCs Modbus TCP Devices

SmartRail I/O Encoders Bar Code Readers Ethernet I/P PLC

OCS-I/O Pumps SCADA FTP

Relays OPC Servers ASCII/TCP

Solenoids Serial I/O Other OCS devices

SmartMod I/O
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Chapter 2: Intro to the CPU200/250

2.4: Features of CPU200/250
Unique features of the CPU200/250 include the following:

n Small, sleek profile saves space and resources.
n Physical Specifications

o Metric (mm): 114mm x 125mm x 50mm
o US (inch): 4.50" x 4.92" x 1.97"
o Weight: 9.77oz (277.1g)

n Advanced control capabilities including floating point, multiple auto-tuning PID loops and string handling capabilities
n Intuitive interface
n Removable media for storage of programs and data logging.
n CsCAN networking port for communication
n Cscape programming software that allows all aspects of the CPU200/250 to be programmed and configured from one

integrated application
n Fail-Safe System which allows an application to continue running in the event of “Soft” failures such as (Battery power

loss or Battery Backed register RAM/Application flash corruption)
n Clone Unit allows the user to “clone” the OCS. This feature “clones” application program and unit settings stored in

Battery backed RAM of an OCS. It can then be used to clone a different OCS (but must be the exact same model).
n Suited for most applications across a diverse range of industries.
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Chapter 3: Mechanical Installation

Chapter 3: Mechanical Installation

3.1: Mounting Overview 8
3.2: Requirements 8
3.3: Mounting Orientation 8
3.4: Module Removal 8
3.5: Dimensions 9
3.6: Factors Affecting Panel Layout Design and Clearances 10

3.1: Mounting Overview
The mechanical installation greatly affects the operation, safety, and appearance of the system. Information is provided to
mechanically install the unit such as mounting procedures and other recommendations for correct mechanical installation of the
unit.

3.2: Requirements
l Each module is compact and mounts on the DIN rail. Each I/O module installed adds width in increments of 19mm. The

distance between wiring duct and surrounding modules must be at least 50mm apart.

l The DIN rail clip adds to the overall measurements. The CAN, power, LAN, and serial connectors also add to the
measurements.

l Modules can be added after the base has been installed on the DIN rail and cannot be hot swapped with power
applied.

NOTE: I/O scanning will stop until the correct modules for the system are detected in all slots.

DIN Rail Alignment Requirements

1. Confirm that the DIN rail is in a horizontal position before installing the unit. Horizontal orientation is required to avoid
module slippage on the DIN rail.

2. Align the unit on the DIN rail then push the DIN rail clip to until it clicks into place. Check to ensure that the unit is secure
on the DIN rail.

3.3: Mounting Orientation

NOTE: Do NOTmount the unit on its side as this may cause the unit from slipping off the DIN rail.

l Mount the CPU200/250 with the locking DIN tab facing down.

l As modules mount on a DIN rail, be certain that the DIN rail is in a horizontal position before installing the unit. A
horizontal orientation in required to prevent the unit from slipping off the DIN rail.

3.4: Module Removal
Modules may be removed while powered; however, I/O scanning on the remaining modules will stop and I/O will go into default
state until a new module is inserted and all modules in the configuration are present.

1. Insert a flat-blade screwdriver into the DIN rail latch at the bottom of the module and Pry downwards to release the
latch.

2. Rock the module up and off the DIN Rail.
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3.5: Dimensions
The CPU200/250 must be mounted inside a NEMA 4X enclosure.
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Chapter 3: Mechanical Installation

3.6: Factors Affecting Panel Layout Design and Clearances

WARNING: It is important to follow the requirements of the panel manufacture and to follow all applicable electrical codes
and standards.

The designer of a panel layout must assess the requirements of a particular system and to consider the following design factors.

3.6.1: Clearance/Adequate Space
Install devices to allow sufficient clearance to open and close the panel door.

Minimum Clearance Requirements for Panel Box and Door
Minimum Distance between base of device and sides of cabinet 2” (50.80mm)

Minimum Distance between base of device and wiring ducts 1.5” (38.10mm)

If more than one device installed in panel box (or on door):Minimum
Distance between bases of each device 4” (101.60mm) between bases of each device

When door is closed:Minimum distance between device and closed door
(Be sure to allow enough depth for the OCS.) 2” (50.80mm)

3.6.2: Grounding
Panel Box: The panel box must be properly connected to earth ground to provide a good common ground reference.
Panel Door: Tie a low impedance ground strap between the panel box and the panel door to ensure that they have the same
ground reference.

WARNING: Be sure meet the ground requirements of the panel manufactuer and also meet applicable electrical codes and
standards.

3.6.3: Temperature/Ventilation
Ensure that the DIN Rail layout design allows for adequate ventilation and maintains the specified ambient temperature range.
Consider the impact on the design if operating at the extreme ends of the ambient temperature range. For example, if it is
determined that a cooling device is required, allow adequate space and clearances for the device in the panel box or on the
panel door if DIN rail is mounted inside.

3.6.4: Noise
Consider the impact on the panel layout design and clearance requirements if noise suppression devices are needed. Be sure to
maintain an adequate distance between the unit and noisy devices such as relays, motor starters, etc.
For details on output protection, especially when using contactors and solenoids, see MAN0962.

3.6.5: Shock and Vibration
The unit has been designed to operate in typical industrial environments that may inflict some shock and vibration on the unit.
For applications that may inflict excessive shock and vibration, use the correct dampening techniques or relocate the unit to a
location that minimizes shock and/or vibration.
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3.6.6: Panel Layout Design and Clearance Checklist
The following list provides highlights of panel layout design factors:

n Meets the electrical code and applicable standards for proper grounding, etc.?
n Meets the panel manufacturer’s requirements for grounding, etc.?
n Is the panel box properly connected to earth ground? Is the panel door properly grounded? Has the appropriate

procedure been followed to properly ground the devices in the panel box and on the panel door?
n Are minimum clearance requirements met? Can the panel door be easily opened and closed? Is there adequate space

between device bases as well as the sides of the panel and wiring ducts?
n Is the panel box deep enough to accommodate the controller?
n Is there adequate ventilation? Is the ambient temperature range maintained? Are cooling or heating devices required?
n Are noise suppression devices or isolation transformers required? Is there adequate distance between the base of the

controller and noisy devices such as relays or motor starters? Ensure that power and signal wires are not routed in the
same conduit.

n Are there other requirements that impact the particular system, which need to be considered?
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Chapter 4: Electrical Installation
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4.3: Primary Power Port 14
4.4: Installation Notice 15

NOTE: The datasheet is the first document to refer to for model-specific information. Refer to the Documentation Search on
the Horner website.

4.1: Ground Specifications
Ideally, a ground resistance measurement from equipment to earth ground is 0Ω. In reality it typically is higher. The US National
Electrical Code (NEC) states the resistance to ground shall not exceed 25Ω. Horner Automation recommends less than 15Ω
resistance from the equipment to ground. Resistance greater than 25Ω can cause undesirable or harmful interference to the
device.
Grounding Definition - The term ground is defined as a conductive connection between a circuit or piece of equipment and the
earth. Grounds are fundamentally used to protect an application from harmful interference
causing either physical damage such as by lightning or voltage transients or from circuit disruption often caused by radio
frequency interference (RFI).

4.2: How to Test for Good Ground
In order to test ground resistance, a Ground Resistance Tester must be used. A typical Ground Resistance Meter Kit contains a
meter, two or three wire leads, and two ground rods. Instructions are supplied for either a two-point or a three-point ground test.
The figure shows a two-point ground connection test.

Page 13 of 99
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Chapter 4: Electrical Installation

4.3: Primary Power Port
The Primary Power Range is 10-30VDC.

Primary Power Port Pins
PIN Signal Description
1 Ground Frame Ground

2 DC- Input Power Supply Ground

3 DC+ Input Power Supply Voltage

4.3.1: DC Input/Frame
l Solid/StrandedWire: 12-24 AWG (0.511 - 2.5 mm²)
l Strip length: 0.28” (7mm)
l Torque, Terminal Hold-Down Screws: 4.5 – 7 in•lbs (0.50 – 0.78 N•m)
l DC- is internally connected to I/O V-, but is isolated from the V- connection of both CAN1 and CAN2 ports. A Class 2

power supply must be used.

4.3.2: Power Up
1. OPTIONAL: Attach ferrite core with a minimum of two turns of the DC+ and DC- signals from the DC supply that is

powering the controllers.

2. Connect to earth ground.
3. Apply recommended power.

NOTE: Refer to datasheet for power specifications
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4.4: Installation Notice
When products are installed in environments of extreme Electromagnetic Interference (EMI), it is advised to take extra measures
to ensure correct operation. In addition to the installation procedures, Horner APG recommends the following steps to ensure
additional immunity in potential extreme EMI situations:

1. Always use a high-quality power supply. EMC ratings that include both EN61000-6-2 and EN55022 Class B can
provide a reasonable amount of immunity with minimal emissions.

NOTE: Power supplies that permit or create occasional transients can disrupt a system and can be nearly
impossible to troubleshoot.

2. Power lines should be twisted and as short as possible.

3. Always attach ground wire with the heaviest gauge and shortest wire as possible.

4. Route cabling perpendicular to peripheral equipment wiring. Never install cabling parallel to any power or high voltage
lines.

5. CAN cabling used should be Belden DeviceBus 3084A or 3082A. If CAN power is required externally, apply power as
close to the CAN port as possible. Avoid powering CAN through the network cable. Always connect the common (0V,
black) wire between devices and leave the +24 volt (Red) wire open when independently powering each node.

6. The CAN cabling should have a 360° clamp installed on the braid shield at both ends of the cable and attached to
ground. In certain noise environments, attaching the shield at one end only provides the necessary immunity.

7. All analog input and output cabling should be Belden 8441 or equivalent, and in some noise environments may require
a clamp as shown in the previous step.

8. Run all cable in metal conduit, separate from power and high voltage lines

9. Attach a ferrite with a minimum of two turns to interconnect lines to the device. This includes power, analog and
communication lines. Horner offers a Ferrite Core (part number HE-FBD001) on the Horner APG website
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Chapter 5: Load/Run/Stop Switch Modes

5.1: Load/Run/Stop Switch 17

5.1: Load/Run/Stop Switch
The Load/Run/Stop switch in CPU250 is a multi-purpose switch which has three modes as shown in the following figure.
This switch supports various functionalities, and some functionalities supported by a specific LED pattern that tells the
user if the intended operation has started, completed, or failed.

A switch provides control of the following CPU250 modes: RUN, STOP, and LOAD.

Mode Description

RUN The unit is actively executing any programmed functions
and operations.

STOP Halts/stops the execution of all operations that may be
underway.

LOAD For loading a program from a microSD card and when
updating firmware.

l The operational mode of the CPU250 may be changed with Cscape. If Cscape is used to force the device into
Run mode while the switch is in Stop, the RUN LED will blink rapidly.

l If the mode is changed in Cscape to a mode that differs from the switch setting, a warning message will be
presented to confirm.

l %SR58 can be used inhibit the ability of the switch to set the device to Run mode. Setting %SR58 to '1' means
the run mode can only be changed from Cscape.

5.1.1: Status LEDs
Firmware Download In Progress/Complete Indicators

l OK and RUN flashing alternately indicates a firmware download is in progress.

l When the flashing stops, the firmware download is complete and the unit reboots (approximately 30 seconds).

NOTE:When flashing together, the firmware download has failed, and the number of flashes indicates the error. There
will be a two second gap and the pattern will be repeated. The number of flashes and the associated error are as
follows:
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l 2 Flashes - The MAC ID is empty.

l 3 Flashes - The internal MAC file is corrupt.

l 4 Flashes - The MAC ID TXT file is invalid.

l 5 Flashes - The MAC ID file is not found or the microSD card is empty or missing system files.

LED BEHAVIOR UNDER DIFFERING CONDITIONS
Status Power OK RUN MS NS

OFF No power
applied Self-test fail Stop mode Self-Test of

Remote I/O Fail

Network ID Fault
or Duplicate ID
Fault

ON 9-30VDC
applied Self-test pass Run mode

Self-Test of
Remote I/O OK &

Configured
Network Normal

FLASHING
(1Hz) N/a I/O forcing

enabled
Do I/O mode
(Amber)

Power-up State /
Waiting for

Configuration

Communications
Timeout with OCS

Power ON
without OCSIO
modules
connected

Solid Green Any Any OFF
Blinking Green
(modules not
detected)

Power ON
with OCSIO
modules
connected

Solid Green Any Any
Blinking Green
(configuration
mismatch)

Solid Green On
(Modules
detected)

OCSIO
configuration
downloaded

Solid Green Any Any
Solid Green
(configuration
matched)

Solid Green On
(Modules
detected)

Diagnostics OK Solid Green Solid Green OFF Any Any

Diagnostics
not OK
(fault indication)

Solid Green OFF OFF Any Any

Device in
STOPmode Solid Green Any OFF Any Any

Device in
RUNmode Solid Green Any Solid Green Any Any

Device forced to
RUNmode using
Cscape while

Solid Green Any Blinking Green Any Any
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LED BEHAVIOR UNDER DIFFERING CONDITIONS
switch in STOP
position

Device in
DO I/O Mode Solid Green Solid Green Blinking Yellow Any Any

BOOT update Solid Green OFF OFF OFF OFF

Firmware
Update Solid Green Blinking Green Blinking Green Any Any

Program Clear Solid Green Any OFF Blinking red
for 30 seconds Any

Program
Load Start Solid Green Any OFF Blinking Green Blinking Green

Program
Load Fail

Solid Green OFF OFF Blinking red
for 3 seconds

Blinking red
for 3 seconds

CPLD Loaded
successfully Solid Green

Blinks green for
5 times after 30

seconds
OFF OFF OFF

Calibration Mode
ON Solid Green Blinking green

at 2Hz Any Any Any

I/O Forcing Solid Green Blinking green
at 1Hz Any Any Any
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6.1: OCS-I/O Overview 21
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6.3: Removing an OCS-I/O 21

6.1: OCS-I/O Overview
OCS-I/O is a modular, flexible CsCAN I/O platform that can be applied as a local expansion I/O. The OCS-I/O can be seamlessly
integrated with CPU200/250 to build-in even more custom functionality.

6.2: OCS-I/O Installation
The OCS-I/O is compact and mounts on DIN-rail. Each I/O module installed adds width in increments of 19mm.

NOTE: The distance between wiring duct and surrounding modules, above and below each module, should be at least 50mm
apart.

Modules can be added after the CPU200/250 base has been installed on the DIN-rail and cannot be hot swapped with power
applied.

NOTE: I/O scanning will stop until the correct modules for the system are detected in all slots.

1. Connect the bus connectors together to form a backplane that can accept up to 8 modules including the CPU200/250
or another base.

2. Snap the bus connectors into the DIN rail. The DIN rail should be 35 mm × 7.5 mm and made to EN 60715 standards.

3. Place the CPU200/250 to the leftmost connector.

4. Insert OCS-I/O modules by latching at the top of the DIN rail first and rocking down until the latch at the bottom of the
DIN rail engages.

6.3: Removing an OCS-I/O
1. To remove a module, insert a flat blade screwdriver through the orange loop and into the metal DIN rail latch at the

bottom of the module.

2. Pry down to release the latch, then rock the module up and off the DIN Rail. Modules may be removed while powered;
however, the I/O scanning on the remaining modules will stop and I/O will go to the default state until a new module is
installed.
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7.1: Register Definitions 23
7.2: %S Registers 24
7.3: %SR Registers 24
7.4: I/O Register Map 25
7.5: Resource Limits 25
7.6: PWM Functions Registers Map 25
7.7: Stepper Function Register Map 26
7.8: HSC Register Map 26
7.9: OCS-I/O Status Register 27
OCS-I/O Status Register 27

For I/O Register Maps for individual controllers, refer to the Horner website Document Search page.
There are two types of System Registers that may be used during programming. %S registers indicate the status of several
system operations. %SR registers indicate the state of many system operations and can be used to control them in several
cases. Some of the system registers have predefined I/O names, though they may still be changed if desired.

7.1: Register Definitions
When programming the OCS, data is stored in memory that is segmented into different types. This memory in the controller is
referred to as registers. Different groups of registers are defined as either bits or words (16 bits). Multiple registers can usually be
used to handle larger storage requirements. For example, 16 single-bit registers can be used to store a word, or two 16-bit
registers can be used to store a 32-bit value.

Types of Registers

%AI = Analog Input 16-bit input registers used to gather analog input data such as voltages, temperatures, and
speed settings coming from an attached device.

%AQ = Analog Output 16-bit output registers used to send analog information such a voltages, levels or speed
settings to an attached device.

%D = Display Bit These are digital flags used to control the displaying of screens on a unit which has the
ability to display a screen. If the bit is SET, the screen is displayed.

%I = Digital Input Single-bit input registers. Typically, an external switch is connected to the registers.

%K = Key Bit Single-bit flags used to give the programmer direct access to any front panel keys appearing
on a unit.

%M = Retentive Bit Retentive single-bit registers.

%Q = Digital Output Single-bit output registers. Typically, these bits are connected to an actuator, indicator light
or other physical outputs.

%R = General Purpose
Register Retentive 16-bit registers.

%S = System Bit Single-bit bit coils predefined for system use.

%SR = System Register 16-bit registers predefined for system use.

%T = Temporary Bit Non-retentive single-bit registers.
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7.2: %S Registers
%S registers indicate system status as follows:

%S Registers
S# Name Predefined I/O Name Notes

%S1 First Scan FST_SCN On for 1 scan only each time the program is first run

%S2 Network OK NET_OK If on, the Network is OK

%S3 10ms pulse T_10MS Cycling pulse that is high for 5ms and low for 5ms

%S4 100ms pulse T_100MS Cycling pulse that is high for 50ms and low for 50ms

%S5 1 second pulse T_1SEC Cycling pulse that is high for 500ms and low for 500ms

%S6 I/O OK IO_OK If on, the I/O system is OK

%S7 Always On ALW_ON This bit is always on

%S8 Always OFF ALW_OFF This bit is always off

%S9 Pause Scan PAUSING_SCN On for at least 1 scan prior to Pause 'n Load

%S10 Resume Scan RESUMED_SCN On for 1 scan only after Pause 'n Load is done

%S11 Forcing Present FORCE If on, I/O is presently being forced

%S12 Forcing Enabled FORCE_EN If on, I/O forcing is been enabled

%S13 Net I/O OK NET_IO_OK If on, Network I/O is OK

7.3: %SR Registers
%SR registers are special word-length registers that display and/or control system operations in the controller. Not all controllers
support all defined system registers.
Please refer to the Cscape help file for a complete list of registers.

NOTE: %SR58 is reserved for User LEDs. See Cscape System Register Tables for additional information.
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7.4: I/O Register Map

NOTE: These registers can be used as general purpose registers

Fixed Address Digital/Analog I/O Function Registers

%I

Digital inputs %I1-8

Flexible Digital or Analog Inputs %I9-16

Reserved %I17-24

Digital output 1-4 fault
(undervoltage or overcurrent or over temperature)

%I25

Reserved %I26-34

%Q

Digital Outputs %Q1-10

Reserved %Q11-24

Clear Digital Output 1-4 fault %25

%AI
Flexible Digital Inputs or Analog Inputs %AI1-8

Reserved %AI9-16

%AQ
Analog Outputs %AQ1-8

Reserved %AQ9-24

7.5: Resource Limits
Resource Value

%I 2048

%Q 2048

%AI 512

%AQ 512

%T 16384

%M 16384

%R 50000

%D 1023

%K 4

%S 13

%SR 192

Ladder Code 2MB

7.6: PWM Functions Registers Map
Register PWM
%AQ13-14 PWM1 Duty Cycle

%AQ15-16 PWM1 Frequency

%AQ17-18 PWM2 Duty Cycle

%AQ19-20 PWM2 Frequency
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7.7: Stepper Function Register Map
Register Stepper
%AQ9 Stepper-1 Start Frequency

%AQ10 Stepper-1 Run Frequency

%AQ11-12 Stepper-1 Acceleration Count

%AQ13-14 Stepper-1 Run Count

%AQ15-16 Stepper-1 Deceleration Count

%AQ17 Stepper-2 Start Frequency

%AQ18 Stepper-2 Run Frequency

%AQ19-20 Stepper-2 Acceleration Count

%AQ21-22 Stepper-2 Run Count

%AQ23-24 Stepper-2 Deceleration Count

I30 Stepper1 - Run Status

I31 Stepper1 - Ready/Done Status

I33 Stepper2 - Run Status

I34 Stepper2 - Ready/Done Status

7.8: HSC Register Map
Register Totalizer / Frequency / Pulse Quad
%AI9-10 HSC1 (function) Accumulator Quad 1 Accumulator

%AI11-12 HSC2 (function) Accumulator

%AI13-14 HSC3 (function) Accumulator Quad 2 Accumulator

%AI15-16 HSC4 (function) Accumulator

%AQ9-10 HSC1 Preset

%AQ11-12 HSC2 Preset

%Q17 Clear HSC1 Clear Quad 1

%Q18 Clear HSC2 Set Quad 1

%Q19 Clear HSC3 Clear Quad 2

%Q20 Clear HSC4 Set Quad 2
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7.9: OCS-I/O Status Register
Register 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1

1 IOE RSVD CME NO_CFG

2 IOCS RSVD WDG TRIP RSVD

3 IO MOD1 FW VER

4 IO MOD2 FW VER

5 IO MOD3 FW VER

6 IO MOD4 FW VER

7 IO MOD5 FW VER

8 IO MOD6 FW VER

9 IO MOD7 FW VER

10 RSVD

OCS-I/O Status Register

CME Each bit (bit8 – bit2) represents communication error of each I/O modules
(Module 7 to Module 1)

IOCS Each bit (bit16 – bit10) represents I/O modules calibration status (Module 7 to Module 1)

IOE Each bit (bit16 – bit 10) represents I/O modules error (Module 7 to Module 1)

NO_CFG IO Module’s configuration status

Register 3-9 Represents FW version of I/O modules connected

RSVD Reserved for future use

WDG TRIP Each bit (bit8 – bit 2) represents I/O modules watchdog trips (Module 7 to Module 1)

–
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- Chapter Applies to CPU250 Only-

8.1: Built-in Digital and Analog I/O Overview
The device is a compact unit that contains high density and very versatile I/O. Using the I/O properly requires wiring to the proper
terminals and configuring Cscape properly. This section will offer some tips and suggestions to configure the I/O properly. For
the register mapping of the I/O, refer to "System Register Tables" on page 1.

8.1.1: Model and I/O Overview
Micro CPU Solid State Digital Outputs Digital Inputs Analog Inputs Analog Outputs
HE-CPU200

HE-CPU250 ü ü ü ü

For more details, see the controller datasheet via Document Search.
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Digital Wiring Diagrams

Digital Input Wiring Digital Output Wiring
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Digital and Analog I/O Function Map

Port Map

Digital Inputs Commons Voltage Outputs

I1 0V V1

I2 0V V2

I3 0V V3

I4 0V V4

I5

I6 Outputs Current Outputs

I7 Q1 mA1

I8 Q2 mA2

Q3 mA3

Flexible Inputs Q4 mA4

I9 Q5

I10 Q6 External Voltage In

I11 Q7 V+

I12 Q8

I13 Q9

I14 Q10

I15
I16

Digital / PWM Output Configuration
Solid-State Digital Outputs
Solid-state digital outputs are generally used to activate lamps, low voltage solenoids, relays, and other low voltage and low
current devices.
NOTE: The digital outputs are “sourcing” outputs. This means the output applies a positive voltage to the output pin when turned
ON. When turned off, the output applies approximately zero volts with respect to the I/O ground.

l The digital outputs have electronic short circuit protection and current limiting. While these electronic protections work
in most applications, some applications may require external fusing on these outputs.

l The digital outputs are typically controlled via %Q bits in the register mapping. Some of the outputs are designed for
high-speed applications and can be used for PWM or frequency output applications.

When the controller is stopped, the operation of each output is configurable. The outputs can hold the state they were in before
the controller stopped or they can go to a predetermined state. By default, digital outputs turn off. For more information on Stop
State, refer to Cscape Configuration.

Page 31 of 99

../../../../../../../Content/X Series/X4/X4_UM/X4_Cscape_Config.htm


Chapter 8: General I/O Configuration

8.2: Flexible Analog Inputs
l The flexible analog inputs can be configured to measure current (mA) and voltage.

l Flexible Analog input can be configured from Cscape or through dynamic configuration registers to read 0-10V, 0-
20mA or 4-20mA.

The analog inputs have a digital filter that can be used to filter electrical noise that may be unavoidable in some installations. The
downside to digital filtering is the inputs will respond more slowly to sudden changes in the actual input.
NOTE: To configure digital filtering, refer to the datasheet and the Cscape Configuration chapter.

Analog Input Overcurrent Detection
When flexible inputs are configured as 0-20 or 4-20mAmode, overcurrent in the channel can be detected and it is indicated in
system register %SR196. Each bit in this register corresponds to the analog input channels

l SR196 Bit 1 – High- AI Channel 1 (mA) Overcurrent Detection.

l SR196 Bit8 – High – AI Channel 8 (mA) Overcurrent Detection.

NOTE: Once Overcurrent is detected in any channel, it will hold the last value and an Idle to Run mode transition is required
to make the channel normal.

NOTE: Overcurrent detection is not applicable for Volt mode.

Config Register
If a Config Register is configured, it takes immediate precedence over other configuration for the I/O, resulting in requiring valid
values in the registers. These values can be changed during runtime, so show additional caution to not mistakenly overwrite
these values with program logic.

8.3: Flexible Digital/Analog Input Dynamic Configuration Registers
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Register (Rx) Config Values
1 Mode 0 (Digital) 1 (Analog)

2 Type

0 (24V) 1
(12V) 2
(5V) 3
(Custom)

0 (0-10V)
1 (0-20mA)
2 (4-20mA)

3

Data
Range
(Analog)
or Custom
Range
(Digital)

ON
Threshold
(5-20V)

10V 20mA 4-20mA
0 (0-4000)
1 (-2000-2000)
2 (0-1000)
3 (Reserved)
4 (Reserved)
5 (0-32000)

0 (0-4000)
1 (-2000 ~ 2000)
2 (0-1000)
3 (0-2000)
4 (Reserved)
5 (0-32000)

0 (0-4000)
1 (-2000 ~ 2000)
2 (0-1000)
3 (Reserved)
4 (400-2000)
5 (0-32000)

4 Custom
Range

OFF
Threshold
5-20 (V)

Not Applicable

Analog Input Filter

Register (Rx) Filter Values
1 0 to 7

Digital Input Active Mode

Register (Rx) Active Mode

1
0 Positive logic
1 Negative logic

NOTE: If Negative Logic is selected, a Custom range is not applicable.

Register (Rx) Config Values
1 Mode 0 Digital 1 Analog

2 Type

0 (24V)
1 (12V)
2 (5V)
3 (Custom)
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Register (Rx) Config Values

3 Data Range N/a

10V 20mA 4-20mA

0 (0-4000)
1 (-2000-2000)
2 (0-1000)
3 (Reserved)
4 (Reserved)
5 (0-32000)

0 (0-4000)
1 (-2000 ~ 2000)
2 (0-1000)
3 (0-2000)
4 (Reserved)
5 (0-32000)

0 (0-4000)
1 (-2000 ~
2000)
2 (0-1000)
3 (Reserved)
4 (400-2000)
5 (0-32000)

4 On Threshold 5-20 (V) N/a

5 Off Threshold 5-20 (V) N/a

Page 34 of 99



Chapter 8: General I/O Configuration

Scaling Analog Inputs & Examples

To access the Advanced Math Scaling function, select Home > View > Project Toolbox. This will open a side bar, and then
select Advanced Math > Scale.

Example 1
The Cscape Scale function, found in the Advanced Math functions, allows for very easy conversion of the raw input value into a
meaningful reading. For example, a pressure transducer may be specified as a 4-20mA signal to signify a 0-2000 psi pressure
reading. With the analog channel set to the 4..20mA range, the raw analog input value, which is in INT format ranges from 0 to
4mA to 32000 for 20mA. Use the Scale function to obtain an Integer pressure reading using the 0-32000 raw input range and the
sensor’s 0-2000psi output range.

Example 2:
If readings with fractions are required, the raw Integer input value must first be translated in REAL, or Floating Point Format, see
note below. The Cscape INT-to-REAL Conversion function may be used to convert the raw input value from INT to REAL format
in an intermediate memory location. The SCALE function, specified as REAL type, may be used to scale the converted raw value
into a reading that supports digits beyond the decimal place, i.e. 475.25psi.
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Analog Output Configuration
NOTE: Refer to the datasheet and the I/O chapter for more information.

The analog outputs on devices provide high resolution current outputs and voltages.

When the controller is stopped, the operation of each output is configurable. The outputs can hold the state they were in before
the controller stopped or they can go to a predetermined value. By default, analog outputs are set to a value of zero (0). For more
information on Stop State, refer to "Cscape Configuration" on page 1.

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are selected. Then
select the Local I/O tab.

The I/O configuration dialog screen will appear. Select the required I/O type for further configurations.
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Select Analog Out to open the following dialogue:

The Halt State group box contains items that allow the user to specify how the analog output channels behave when the
controller is stopped. The outputs can either hold their value or default to a value when the controller is stopped.

The Data type and Data range group box allows users to select the type of analog output and their corresponding range.
NOTE: If a Config Register is configured, it takes immediate precedence over other configuration for the I/O, thus requiring valid
values in the registers. These values can be changed during runtime so care needs to be taken to not mistakenly overwrite these
values in program logic.
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Analog Output uses three consecutive 16-Bit registers for configuration and each register has the following description:
Example: If %R400 is configured for Analog Output channel.

Register
(Rx) Config Values

1 Type

0 (0-10V)
1 (0-20mA)
2 (4-20mA)
3 (Disabled)

2 Data Range

10V 20mA 4-20mA

0 (0-4000)
1 (-2000-2000)
2 (0-1000)
3 (Reserved)
4 (Reserved)
5 (0-32000)

0 (0-4000)
1 (- 2000 ~
2000)2 (0-1000)
3 (0-2000)
4 (Reserved)
5 (0-32000)

0 (0-4000)
1 (-2000 ~ 2000)
2 (0-1000)
3 (Reserved)
4 (400-2000)
5 (0-32000)

3 Halt State

0 (Current)
1 (Minimum)
2 (Maximum)
3 (Average)
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- Chapter Applies to CPU250 Only-

9.1: Overview
In addition to the compliment of simple analog and digital I/O, the OCS controller supports High Speed Counting (HSC) I/O
functions and may support Pulse Width Modulation (PWM) Output functions. The HSC functions include frequency, totalizing,
pulse width, and quadrature measurement.
The PWM functions include traditional PWM including variable rate and duty, with variable acceleration and deceleration rates,
and a Stepper (limited functionality) with variable acceleration and deceleration rates . To determine function availability, refer to
the model’s Specification/Installation sheet (Digital DC Input/Output sections).

 High Speed I/O Terms Glossary
Accumulator Register used to accumulate or store up a sum or count of many items or events.

Clear A special function to zero out the value in a specific register. (Not used with Frequency or Period
Measurement.)

Disable A special function to prevent the counter from running.

Encoder A sensor or transducer for converting rotary motion or position to a series of electronic pulses

FPGA An integrated, configurable circuit that allows the controller to be programmed to have either two
high-speed counters or four high-speed counters.

Frequency Input The number of times an electromagnetic signal repeats an identical cycle in a unit of time, usually
one second.

Latch (strobe)

A special function that uses a digital logic circuit to store one or more bits. A latch has a data input,
a clock input and an output. When the clock input is active, data on the input is "latched" or stored
and transferred to the output register either immediately or when the clock input goes inactive.
The output retains its value until the clock goes active again.

Marker Input into the OCS that indicates a particular position. Typically, an encoder has a marker output
that represents a specific point in the rotation.

Polarity A Polarity pull-down box is associated with each function and indicates the manner in which the
trigger happens (e.g., High level, Low Level, Falling Edge, Rising Edge).

Preset An address that contains the comparison count for use with direct high-speed output control.

Quadrature
A high-speed device that expresses the phase relationship between two periodic quantities of the
same period when the phase difference between them is one fourth of a period. A coupler in
which the two output signals are 90° out of phase.

Totalizer A counter that sums the total number of cycles applied to its input.
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9.2: High Speed Counter (HSC) Functions
Four dedicated inputs are available that can be configured for one of four modes of operation. Those modes are Frequency,
Count (totalize), Pulse width or period (pulse) and Quadrature measurement. For some modes, more than one HSC input may
be consumed. The measurement value is provided to ladder in a %AI register.

NOTE:While the high-speed input circuitry has a resolution of 1μs, measured edge transitions must not occur faster than
100μs for accurate measurements. Keep in mind that pulse width measurements utilize both the rising and falling edges of
the waveform, thus the pulse width must exist longer than 100μs.

NOTE: The edge polarity selection in the mode parameter for the totalize and pulse width functions (Digital/HSC Input
Configuration) assume Positive Logic regardless of the associated I/O board’s jumper setting for the Digital DC inputs
polarity. If Negative logic is configured when using these functions, the opposite edge polarity must be selected in the mode
parameter.

9.2.1: Frequency
In frequency mode, the frequency of the input signal is written to the accumulator in terms of Hertz (cycles/second). When using
frequency mode, four update selections are provided which specify the width of the sample window.

NOTE: Selecting a shorter sample window provides a quicker measurement (faster response) but lowers the frequency
accuracy (resolution) and increases the minimum frequency measurement limit.

9.2.2: Totalize
In totalize mode, the accumulator is simply incremented each time the input transitions in a specific direction. Totalize mode is
configurable to specify the edge (rising or falling) on which the accumulator is incremented.

Three different options are available to reset the current count:
l Configured reset value - When configuring the Totalize function, a value may be specified under the Counts per Rev

column. When the totalizer accumulator reaches this value minus one (N-1), the accumulator will reset to zero on the
next count. Specifying zero for this value allows the totalizer to count through the full 32-bit range before resetting.

l Ladder control - Setting registers %Q17-20 reset HSC1-4 (respectively) with no additional configuration. When these
registers are asserted, the associated totalizer accumulator is reset and held at zero (level sensitive).

l Direct digital input control (HSC1 and HSC2 only) - HSC3 (%I11) and HSC4 (%I12) may be configured as
hardware digital reset signals for HSC1 and HSC2 (respectively). To enable these inputs as reset signals, specify the
type as Totalize Reset (NOTE: The corresponding Totalize HSCmust be previously configured before this option is
available). The direct digital reset controls are edge sensitive with the edge polarity configurable.

Maximum direct digital reset latency is 100μs.
The totalize function also supports an option which compares the current accumulator value with a supplied Preset Value (PV),
which is provided through a %AQ, and drives a physical digital output based on the that comparison.

l This option (available for HSC1 and HSC2 only) drives Q1 or Q2 output point (respectively) once the associated
totalizer accumulator reaches (or exceeds) the PV value. To enable this function, the corresponding PWM function
output (Q1 or Q2) must be configured for HSCx Output.

NOTE: Q1 and Q2 are PWM function outputs that may be configured independently as one of the following: standard digital
output, PWM, HSCx or stepper output.

Preset values may be modified during run-time. A preset value of zero disables (resets) the totalizer compares function output
causing the output to remain low.
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9.2.3: Pulse
In pulse mode, the high-speed input can measure the width or period of a pulse stream in one of four modes and provides a
continuous indication of the last sampled value.
Width High 1μs Counts – In this sub-mode the accumulator value will contain the number of 1μs counts the pulse is high.

Width Low 1μs Counts - In this sub-mode the accumulator value will contain the number of 1μs counts the pulse is low.

9.2.4: Period Measurement
In period measurement mode, the high-speed input can measure the period of a pulse stream in one of two modes and provides
a continuous indication of the last sampled value. In this mode the Disable and Latch special functions are allowed.
Period Rising Edges 1μs Counts – In this sub-mode the period of the input signal is reported in one (1) μs units. The period
measurement will start on the rising edge of the input.

Period Falling Edges 1μs Counts – In this sub-mode the period of the input signal is reported in one (1) μs units. The period
measurement will start on the falling edge of the input.
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9.2.5: Quadrature
Two HSC inputs are consumed for each of the two possible Quadrature counters. For example, selecting quadrature mode for
HSC 1 will use HSC inputs 1 and 2, which correspond to A and B quadrature signals. Therefore, HSC 1 and 3 may be configured
for quadrature input. Alternately, HSC 3 may be configured to reset HSC1 (quadrature) count on a marker input
Quadrature mode works much like the totalizer except the accumulator will automatically increment or decrement based on the
rotation phase of the two inputs. See the following example for more details. Quadrature inputs are typically used for reporting
the value of an encoder.
Two modes are available for quadrature that select whether the accumulator counts up or down when the phase of input 1 leads
input 2. Check your encoder’s documentation to determine the output form it uses or try both modes to determine if the encoder
counts up when expected.

Using the above waveforms and a HSC input configuration of “Quadrature” - “1 leads 2, count up,” the accumulator will count up
when 1 is rising and 2 is low, 1 is high and 2 is rising, 1 is falling and 2 is high, and when 1 is low and 2 is falling. This results in 4
counts per revolution. So in order to determine the number of cycles, the accumulator would have to be divided by 4.
Three different options are available to reset (or set) the current count:

l Configured Counts per Rev Value - When configuring the quadrature function, a value may be specified under the
Counts per Rev column. When rotation produces an increasing count, the quadrature accumulator resets to zero on
reaching the Counts per Rev count. Alternately, when rotation produces a decreasing count, the quadrature
accumulator is set to Counts per Rev – 1 on the count following zero. Specifying zero for this value allows the totalizer
to count through the full 32-bit range before resetting. For example, if your encoder outputs 1024 counts per revolution,
the value of 1024 can be entered into the configuration for Counts per rev. This will result in a counter that produces
counts in the range of 0 to 1023.

l Ladder Control - Setting registers %Q17 or Q19 resets quadrature (HSC) 1 or quadrature (HSC) 3 (respectively) with
no additional configuration. Setting registers %Q18 or Q20 sets quadrature (HSC) 1 or quadrature (HSC) 3
(respectively) to Counts per Rev – 1.

l Direct Digital Input Control (HSC3) [Marker] - When HSC input 1 and 2 are used for quadrature inputs, an additional
choice of marker input becomes available for HSC input 3. The marker input is typically part of an encoder or motion
system that signals when a cycle of motion is complete. When the marker input is triggered, the accumulator is reset to
zero or to Counts per rev - 1 based on rotation direction. Marker reset operation is enabled when HSC3 is configured
for Marker type. Once selected, one of several modes is available for marker operation. These modes can be sub-
divided into two groups of marker operation.

Asynchronous modes ignore the quadrature inputs and reset the quadrature accumulator to zero on the configured edge
(rising, falling or both). These are the most common settings used. When configuring, asynchronous mode selections are
prefixed with the word Async.
Synchronous modes synchronize the reset (or set) to the selected quadrature input and the selected marker polarity. Figure
11.1 below indicates which mode to select based on the markers timing diagram. Consult the documentation provided with your
encoder to determine the marker pulse timing.

NOTE: The Marker input is sampled within 50μs of the associated quadrature edge. It is left to the user to determine if this
meets the time constraints of the measured drive.

NOTE: If the Marker input pulse consecutively spans more than one of the specified edges, quadrature-decoding operation is
unpredictable.
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*While not displayed in this figure, modes for low level (inverse logic) are also supported for each state.
The accumulator is reset to zero on the specified edge if rotation is clockwise (as shown in figure above). However, if rotation is
reversed, the accumulator is alternately set to Counts per rev – 1 on that same physical edge. When direction is reversed, that
same physical edge is seen (by the internal decoder) as having the opposite edge polarity as shown below.
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9.2.6: Sync Pulse Mode Table
Definition: CPRmost commonly stands for Counts per Revolution, and refers to the number of quadrature decoded states that
exist between the two outputs A and B. With both outputs A and B switching between high and low, there exists 2 bits of
information represented as 4 distinct states.

Mode Direction A (HSC1) B (HSC2) Marker (HSC3) Reset Value
Async, Reset on rising edge Rising 0

Async, Reset on falling edge Falling 0

Async, Reset on both edge Both 0

High, Reset on 1 rising Clockwise Rising High 0

“ Counter Falling High CPR - 1

Low, Reset on 1 rising Clockwise Rising Low 0

“ Counter Falling Low CPR - 1

High, Reset on 1 falling Clockwise Rising High CPR - 1

“ Counter Falling High 0

Low, Reset on 1 falling Clockwise Rising Low CPR - 1

“ Counter Falling Low 0

High, Reset on 2 rising Clockwise Rising High 0

“ Counter Falling High CPR - 1

Low, Reset on 2 rising Clockwise Rising Low 0

“ Counter Falling Low CPR - 1

High, Reset on 2 falling Clockwise Rising High CPR - 1

“ Counter Falling High 0

Low, Reset on 2 falling Clockwise Rising Low CPR - 1

“ Counter Falling Low 0
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9.3: High Speed Counter
When either Q1 or Q2 is configured for HSC operation, HSC1 or HSC2 totalize functions are extended to allow respective direct
output control based on a comparison of the current count and a preset value (PV). Refer to the Totalize section in the HSC
section above for more information.

9.3.1: HSC Functions Register Map
Register Frequency Totalize Pulse Quad
%AI9-10 HSC1 (function) Accumulator Quad 1 Accumulator

%AI11-12 HSC2 (function) Accumulator

%AI13-14 HSC3 (function) Accumulator Quad 2 Accumulator

%AI15-16 HSC4 (function) Accumulator

%AQ9-10 HSC1 Preset

%A11-12 HSC2 Preset

%Q17 Clear HSC1 Clear Quad 1

%Q18 Clear HSC2 Set Quad 1

%Q19 Clear HSC3 Clear Quad 2

%Q20 Clear HSC4 Set Quad 2
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9.4: Pulse Width Modulation (PWM) Functions
On units that support the PWM, two dedicated outputs are available that can be configured for one of four modes of operation.
Those modes are Normal, PWM, HSC (count = PV) and Stepper.
Normal - When either Q1 or Q2 is configured for Normal operation, the digital output registers %Q1 and %Q2 drives that
respective output.
Duty Cycle - The Duty Cycle is a 32-bit value from 0 to 32,000 indicating the relative duty cycle of the output. For example, a
value of 8000 would indicate a 25% duty cycle, a value of 16,000 would indicate a 50% duty cycle. Zero (0) turns the output off,
32,000 turns the output on.

Frequency - The Frequency is a 32-bit value indicating the output frequency in Hertz. One over the frequency is the period.

At controller power-up or during a download, the PWM output is maintained at zero until both the Frequency and the Duty cycle
are loaded with non-zero values.
When the controller is placed in stop mode, the state of the PWM outputs is dependent on the PWM State on Controller Stop
configuration. This configuration allows for either hold-last-state or specific frequency and duty cycle counts.
Specifying zero for either the period or duty causes the PWM output to remain low during stop mode.
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9.4.1: PWM Output Waveform

PWM Output Waveform Table
Rise Time 150ns Max

Fall Time 150ns Max

PWM Period Frequency = 1/Period

9.4.2: PWM Functions Register Map

Register PWM
%AQ13 - 14 PWM1 Duty Cycle (32-bit)

%AQ15 - 16 PWM1 Frequency (32-bit)

%AQ17 - 18 PWM2 Duty Cycle (32-bit)

%AQ19 - 20 PWM2 Frequency (32-bit)
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9.4.3: PWM Examples
Example 1 Duty Cycle Frequency

To get a 50% Duty Cycle @ 10kHz waveform on PWM1: Set %AQ13-14 = 16,000 Set %AQ15-16 = 10,000

Example 2 Duty Cycle Frequency
To get a 25% Duty Cycle @ 5kHz waveform on PWM2: Set %AQ17-18 = 8,000 Set %AQ19-20 = 5,000

Example 3 Duty Cycle Frequency
To turn PWM 1 output ON all the time: Set %AQ13-14 = 32,000 Set %AQ15-16 = Any Value

Example 4 Duty Cycle Frequency

To turn PWM 1 output OFF all the time: Set %AQ13-14= 0 Set %AQ15-16 = Any Value

9.5: HSC Pulse Output
This feature allows configuring the high-speed output to turn ON, OFF, toggle, or as a pulse output. Select Digital Out/PWM to
open the dropdown menu of HSC output options.

l OUTPUT ON: Starts with LOW. When HSC1 accumulator value is greater than or equal to AQ9-10 UDINT value, then
the Output Q1 becomes high, otherwise it will be low.

l OUTPUT OFF: Starts with High. When the HSC1 accumulator value is greater than or equal to AQ9-10 UDINT value,
then the Output Q1 becomes low, otherwise it will be high.

l OUTPUT TOGGLE:When the HSC1 accumulator value is equal to AQ9-10 UDINT value, then the Output Q1 toggles.

l OUTPUT PULSE: The Output Pulse option permits sending a configurable output pulse on a timer match. The starting
analog output permits two additional 32-bit words that define the output pulse in microseconds.

Functionality: When the counter accumulator matches the match value stored in %AQ registers, the HSC output will be
enabled. The firmware will then wait based on the configurable microsecond pulse width. After the elapsed time, the output will
be turned off.

If another match happens while the countdown to turn off the output, then the pulse countdown will restart but the output will not
change state until the countdown happens.

When HSC1 accumulator value is equal to AQ9-10 UDINT value, then the Output Q1 becomes high for AQ27-28 UDINT value
microseconds.

NOTE:

a. Resolution for the pulse width will be limited to 50 microseconds on the OCS series hardware.
b. Match value is stored in register AQ11-12 UDINT for HSC2.
c. AQ29-30 UDINT is Pulse width value for HSC2
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9.6: Stepper Functionality
CPU200/250 supports two stepper functions, one on each high-speed output.
Step Function - A signal that has a zero (0) value before a certain instant of time and a constant nonzero value immediate after
that instant.

The Stepper requires five parameters (%AQ) to be set for operation. These parameters may be set at run-time but are ‘latched’
when the stepper is commanded to start:

Start Frequency (cycles per second)

This value (%AQ9) sets the frequency for the first cycle during the
acceleration phase and the frequency of the last cycle during the
deceleration phase. When an acceleration or deceleration count is
specified, the Start Frequency must be greater than zero (0) and must not
exceed the run frequency or an error is generated.

Run Frequency (cycles per second)
This value (%AQ10) sets the frequency for the last cycle during the
acceleration phase, the consistent frequency during the run phase, and
the frequency of the first cycle during the deceleration mode.

Acceleration Count

This value (%AQ11-12) sets the number of cycles to occur within the
acceleration phase. The frequency of the cycles within this mode will vary
linearly between the specified Start and Run frequency. The Accel count
must not equal 1 or an error is generated. Setting this value to zero (0)
disables this phase.

Run Count

This value (%AQ13-14) sets the number of cycles to occur within the run
phase. The frequency of the cycles within this mode is constant at the
specified Run frequency. The Run count may be any value. Setting this
value to zero disables this phase.

Deceleration Count

This value (%AQ15-16) sets the number of cycles to occur within the
deceleration phase. The frequency of the cycles within this phase will
vary linearly between the specified Run and Stop frequency. The Decel
count must not equal 1 or an error is generated. Setting this value to zero
disables this phase.

Page 50 of 99



Chapter 9: High Speed I/O

The stepper provides two Boolean registers to provide stepper status:

Ready/Done A high indication on this register indicates the stepper sequence can be started (i.e. not
currently busy) and also when the move is completed.

Error
A high indication on this register indicates that one of the analog parameters specified
above is invalid or the stepper action was aborted before the operation was complete.
This register is cleared on the next start command if the error was corrected.

The stepper requires one discrete register to control the stepper action. Setting this register starts the stepper cycle. This register
must remain set to complete the entire cycle. Clearing this register before the cycle is complete aborts the step sequence and
sets the error bit. NOTE: Setting the PLC mode to stop while the stepper is in operation causes the stepper output to immediately
drop to zero and the current stepper count to be lost. NOTE: The stepper output level may cause damage or be incompatible
with some motor drive inputs. Consult drive documentation to determine if output level and type is compatible.

STP Examples: Example 1
Start Frequency Run Frequency Accel Count Run Count Decel Count

10,000,000 steps
control sequence

Set %AQ9 =
2500 (Hz)

Set %AQ10=
5000 (Hz)

Set %AQ11-12=
1,000,000
(Steps)

Set %AQ13-14=
8,000,000
(Steps)

Set %AQ15-16=
1,0000,000
(Steps)

When the start bit is energized, the example starts at 2.5kHz and ramps up to 5kHz during the first 1,000,000
steps. Then, it runs at 5kHz for the next 8,000,000 steps. Finally, during the last 1,000,000 steps it slows to a stop.

STP Examples: Example 2
Start Frequency Run Frequency Accel Count Run Count Decel Count

5,000,000 steps
control sequence

Set %AQ9 = 500
(Hz)

Set %AQ10=
1000 (Hz)

Set %AQ11-12=
2,000,000
(Steps)

Set %AQ13-14=
2,000,000
(Steps)

Set %AQ15-16=
1,0000,000
(Steps)

When the start bit is energized, the example starts at 0.5 kHz and ramps up to 1 kHz during the first 2,000,000
steps. Then, it runs at 1 kHz for the next 2,000,000 steps. Finally, during the last 1,000,000 steps it slows to a stop

STP Examples: Example 3
Start Frequency Run Frequency Accel Count Run Count Decel Count

6,000,000 steps
control sequence

Set %AQ9 = 50
(Hz)

Set %AQ10=
250 (Hz)

Set %AQ11-12=
1,500-0 (Steps)

Set %AQ13-14=
5,500000
(Steps)

Set %AQ15-16=
3,50000 (Steps)

When the start bit is energized, the example starts at 50Hz and ramps up to 250Hz during the first 150,000 steps.
Then, it runs at 250Hz for the next 5,500,000 steps. During the last 350,000 steps it slows to a stop.

NOTE: Prior to the start of a move, the Ready/Done bit for that channel must be ON (%I30 or %I33 for channel 1 and 2
respectfully). The Ready/Done bit will turn OFF during the move, and then back ON once the move is completed.

NOTE: The pulse generation hardware on the OCS can generate any frequency that can be evenly divided into 10MHz
(10,000,000Hz) under the maximum recommended frequencies for each model. This results in a very smooth operation at
lower frequencies, with a progressively choppier operation at higher frequencies, as the units reach their maximum
recommended frequency.

NOTE: The highest usable frequency is 500kHz for the PWM output.
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10.4: Cscape Programming via Serial Port 54
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All OCS Controller models provide two serial ports, which are implemented with a single 8-position modular jack that is labeled
MJ1/2. The MJ1 serial port is RS-232 while the MJ2 port is RS-485. MJ1 defaults to OCS programming by connecting it to the
COM port of a PC running Cscape. In addition, both MJ1 and MJ2 can be used for application-specific communication, using a
variety of standard data exchange protocols.

10.1: Port Descriptions
n The MJ1 serial port contains a RS-232 interface with RTS/CTS handshaking.
n The MJ2 serial port contains half-duplex RS-485 interface with no handshaking. The MJ2 RS-485 interface provides

switchable termination and bias resistors internally.

10.2: Wiring—MJ1/MJ2 Serial Ports

2 Serial Ports on 1 Modular jack (8p8c)

MJ1: RS-232 w/Full Handshaking
MJ2: RS-485 Half-Duplex - RS-485 termination and
biasing via System Register

MJ1 & MJ2 PINS
PIN SIGNAL DIRECTION
8 TXD (MJ1) OUT

7 RXD (MJ1) IN

6 0V COMMON

5 +5V@ 60mA OUT

4 RTS (MJ1) OUT

3 CTS (MJ1) IN

2 RX-/TX-/- (MJ2) IN/OUT

1 RX+/TX+/+ (MJ2) IN/OUT
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10.3: RS-485 Termination and Biasing
Termination - Proper RS-485 termination minimizes reflections and improves reliability.
The MJ2 serial port allows an internal termination resistor to be placed across pins 1 and 2 by software control. Only the two
devices physically located at the endpoints of the RS-485 network should be terminated.
This termination is only in place when the OCS Controller is powered on. This would typically only be an issue if the OCS
Controller is being used as a slave on the RS-485 network. In that case, the electronic termination should not be used, but a
physical external termination resistor should be used instead.
Biasing - RS-485 biasing passively asserts a line-idle state when no device is actively transmitting, which is useful for multi-drop
RS-485 networking. The MJ2 serial port allows internal bias resistor to be activated by software control, pulling pin 1 up to 3.3V
and pulling pin 2 down to ground.

NOTE: If biasing is used, it should be enabled in only one of the devices attached to the RS-485 network.

Biasing Details:
n %SR152.3 enables RS-485 Port Termination
n %SR164.1 enables RS-485 Port Biasing

10.4: Cscape Programming via Serial Port
MJ1 is the serial port available for programming. The connection is RS-232 and is compatible with the Horner programming
cable kits HE-XCK or HE-XCPK. Unlike some other OCSmodels, the MJ2 port cannot be configured as a programming port.
The USB port is also available for programming.
The “Set Serial Ports” option in the OCS SystemMenu contains an entry for Default Programming Port (Dflt Pgm Port).
However, the entry is fixed at MJ1-232. No OCS configuration is required to use either the MJ1 serial port or USB port for
programming.

NOTE: Only one Cscape software connection is allowed at a time.

10.5: Ladder-Controlled Serial Communication
Using Serial Communication function blocks, both MJ1 and MJ2 support Generic, Modbus Master and Modbus Slave Protocols.
In addition, external modems can be connected and accessed using Init, Dial and Answer Modem function blocks.

10.6: Configuration by USB

NOTE: The unit must be connected via the USB port to the PC or laptop.

It is possible to load the program and monitor data via the USB. To load by USB, configure the communications port in Cscape
as follows:
Navigate to: Home Tab> Controller and select the Connection Wizard.
It is possible to download or upload and use the data monitoring functions once connected.

NOTE: It is advisable to use an isolated USB cable between the PC or laptop and the OCS Controller when third party
devices are connected to the OCS Controller to avoid damage to the PC or laptop and/or the OCS Controller.
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NOTE: For additional CAN information, refer to the CAN Networks manual (MAN0799) via Documentation Search for more
details .

11.1: Overview
The CPU200/250 provides a CAN networking port, which is implemented with an 8-pin RJ-45 modular jack. The connector is
labeled CAN and is red.

CAN Port Wiring

Modular jack (8p8c)

CAN Pin Assignments
PIN SIGNAL
8 No Connection
7 Ground
6 [CAN] Shield
5 No Connection
4 No Connection
3 Ground
2 CAN Data Low
1 CAN Data High
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Cscape Programming by CAN
The CAN port supports CsCAN Programming Protocol. If a PC has a CAN interface installed (by PCI card or USB), and the PC
CAN port is connected to the CPU200/250 CAN port, then Cscape can access the CPU250 for programming and monitoring.
In addition, the CPU200/250 supports single-point-programming of all CPU200/250 and other Horner controllers that are
connected to a CAN network. If the PC COM port is connected to the CPU200/250 programming port, then the CPU200/250 can
act as a pass-through gateway allowing Cscape to access all CPU200/250 and Horner controllers that are attached to the CAN
network.

Ladder-Controlled CAN Communication
Using Put and Get Network Words function blocks, the CAN port can exchange digital and analog global data with other
CPU200/250, or Horner controllers attached to the CAN network.
In addition, Put and Get Network Heartbeat function blocks allow nodes on the CAN network to regularly announce their
presence and to detect the presence (or absence) of other nodes on the network.

Using CAN for I/O Expansion (Network I/O)
Connecting remote I/O to the CPU200/250 CAN port allows the CPU200/250 I/O to be economically expanded and distributed. A
variety of remote I/O modules is available for this purpose.

CAN and Termination and Bias
If there is a controller-to-controller communication on a network, and a CPU200/250 will be at either end, then it is recommended
that onboard electronic termination NOT be used. Physical external resistors should be used instead. In this case, utilizing RJ-45
to open-style connector will make termination easier.

NOTE: %SR152 enables CAN port termination.

NOTE:When powered down, the biasing and termination is no longer in effect.
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NOTE:  Refer to the Ethernet Supplement (SUP0740)on the Document Search page for more details.

12.1: Ethernet Module Protocols
The following table describes the Ethernet Module Protocols and features supported by the Ethernet port on an OCS controller.

Protocol/Feature Protocol/Feature Description
ASCII over TCP/IP ASCII Data over Ethernet

EGD Ethernet Global Data

Ethernet /IP ODVA CIP over Ethernet

FTP (File Server) File Transfer Protocol

ICMP (Ping) Internet Control Message Protocol

Modbus Slave Modbus over Ethernet

NTP Protocol Network Time Protocol

12.2: Ethernet System Requirements
Full Ethernet functionality requires:

n PC running Cscape Programming Software Version 9.8 or later (for configuration).
n OCS controller with onboard Ethernet port.

12.3: Ethernet Module Specifications
Speeds 10 BASE-T Ethernet (10Mbps), 100BASE-Tx Fast Ethernet (100Mbps)

Modes Half or Full Duplex

Auto-Negotiation Both 10/100Mbps and Half/Full Duplex

Connector Type Shielded RJ-45

Cable Type (Recommended) CAT5 (or better) UTP

Port Auto MDI/MDI-X (Auto Crossover)
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12.4: Ethernet Module Configuration

NOTE: The following configuration is required for all applications regardless of the protocols used. Additional configuration
procedures must be performed for each protocol used.

To configure the Ethernet Module, use Cscape Programming Software to perform the following steps:
l Step 1: On the main Cscape screen, select the Home Tab > Controller menu and its Hardware Configuration sub-

menu to open the Hardware Configuration dialog.

l Step 2: If configuring a different OCSModel than the one shown in the Hardware Configuration dialog, click on the
topmost Config button, select the desired OCSModel, and then clickOK.

l Step 3: Click Config to the right of the LAN1 for LAN 1 or LAN2 for LAN 2, revealing the Ethernet Module Configuration
dialog.

Configure the following: 

l IP Address: Enter the static IP Address for the Ethernet Module being configured.

NOTE: IP Addresses are entered as four numbers, each ranging from 0 to 255. These four numbers are called
octets, and they are always separated by decimal points. See also: "Ethernet Configuration – IP Parameters" on
page 62

l Net Mask: Enter the Net Mask (sometimes called Subnet Mask) being used by all nodes on the local network. Typical
local networks use Class C IP Addresses, in which case the low octet (rightmost number) is used to uniquely identify
each node on the local network. In this case, the default Net Mask value of 255.255.255.0 should be used.

l Gateway: Enter the IP Address of a Gateway Server on the local network that allows for communication outside of the
local network. To prevent the Ethernet Module from communicating outside the local network, set the Default Gateway
IP Address to 0.0.0.0 (the default setting).

l Status Register: Enter an OCS Register reference (such as %R100) to indicate which 16-bit OCS register will have
the Ethernet Status word written to it. The table shows how this register value is formatted and explains the meaning of
each bit in the Status Word.
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Ethernet Status Word Register Format
High Byte Low Byte

Bit
16

Bit
15 Bit 14 Bit

13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1

0 0 Dup Spd 0 Rx Tx Link TCP Connections

Status Bit Status Indication
Status Values

Minimum Maximum
0 Reserved Always 0

Dup Link Duplex (Auto-Negotiated) 0 = Half
Duplex

1 = Full
Duplex

Spd Link Speed (Auto-Negotiated) 0 = 10 Mbps 1 = 100 Mbps

Rx Receive State 0 = Inactive 1 = Active

Tx Transmit State 0 = Inactive 1 = Active

Link Link State 0 = Down 1 = Up

TCP Connections Total Number of Active TCP Connections (CsCAN, SRTP, Modbus,
EtherNet/IP, FTP, HTTP) 0 40

l Version Register: Enter an OCS Register reference (such as %R101) to indicate which 16-bit OCS register will have
the Ethernet Firmware Version written to it. The value stored in the Version Register is (Ethernet Firmware Version *
100). For example, for Ethernet Firmware Version 4.30, the Version register will contain 430.

l Get Setting From: “Get settings from” allows the programmer to either configure the IP Address, Net Mask, or
Gateway for two functions: Configuration or Register.

l Configuration: The configuration for the IP Address, Net Mask, Gateway, or DNS Server will be assigned using the
value in the Default Settings in this window.

l Register: The configuration for the IP Address, Net Mask, Gateway, or DNS Server will be assigned using the values
in the registers assigned.
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12.5: Ethernet Configuration – IP Parameters
For primary operation, the IP address, Net Mask, and Gateway should be set in the LAN config of the Cscape Hardware
Configuration. There are options to get IP parameters from the LAN Config or to get parameters from registers.The following
points on IP parameter configuration should be considered.

IP Parameters in Non-Volatile RAM: The IP parameters of the Cscape LAN Config are written to non-volatile RAM on power
down.

“Cscape LAN Config”/“Get Settings from” Configuration: When ‘Get settings from’ is set to Configuration, the IP
parameters specified under ‘Static Configuration’ is used after downloading to the controller.

n The IP parameters always follow the values in the registers unless the OCS unit is placed in idle mode. Then the IP
parameters can be edited in SystemMenu/Set Networks. When the OCS is placed back into run mode, it reverts to the
registers for IP parameters.

DHCP: When the 'Use DHCP' box is checked, the IP Address, Net Mask, Gateway, and DNS Server are automatically set,
obtaining their parameters from the connected server. The parameters obtained by the server are accessible by the addressing
assigned under the dynamic configuration.

12.6: Ethernet Module Protocol Configuration
The Protocol Support area contains a list of all the resident protocols supported by the platform being configured. To activate a
protocol, check its checkbox.
For protocols that require additional configuration, click on a listed protocol to select it and then click the Configure Selected
Protocol button. This will open a new dialog with configuration options for the selected protocol.

NOTE:  Refer to the Ethernet Supplement (SUP0740)on the Document Search page for more details.
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13.1: Overview
Through loadable protocol device drivers, certain models of the OCS family can provide the ability to exchange data with remote
devices such as variable-frequency drives, PLCs, and remote I/O devices. This feature greatly expands OCS control capability
with negligible effect on OCS ladder scan time.
Remote devices that communicate serially must do so under certain rules of data transfer known as a protocol. Many device
manufactures have created their own protocol for communications with their device. For a OCS to communicate with a specific
device, it must be loaded with the corresponding serial communications protocol device driver that supports that protocol.

A limited number of protocol device drivers are packaged with the Cscape distribution; however, as more are developed, they
will be made available as add-on packages. A device driver is typically distributed as a Windows module, which contains the
configuration menus, help files and the target executable driver code. When updating device drivers, an install routine loads the
device driver to the Cscape directory structure and makes that driver available to Cscape applications.
Once installed, the protocol device driver can be included as part of a Cscape application by selecting it from a list of installed
protocol device drivers and attaching it to the desired serial port (Home > Protocols). Only one protocol device driver can be
associated with a serial port, though some OCSmodels support multiple protocols on a single EtherNet port.

Once the protocol is selected for a specific port, that port must be configured to match the bit transfer size and rate of the target
device(s). This is configured under the Network Configmenu, which contains port specific information such as the basic serial
port parameters (i.e. baud rate, stop bits parity, retries, etc.). In addition to the serial port parameters, this menu also contains the
transaction scan update control configuration and any network level protocol specific configuration.

Once the network is configured, each device on the serial communications network must be configured. For some
communications (i.e. RS-232), the network can be limited to one device. The devices are configured under the Device Config
menu, which contains an arbitrary device name, the device ID and optionally a OCS status register that contains any device fault
information.

Once each device(s) is configured, a Scan List of entries must be created which defines the transfer of data between a local
(OCS ) register(s) and a remote device register(s). These entries are created under the Data Mapping menu, which contains a
OCS register, a target device ID, a target device register address, the number of registers to transfer, and update type.

Each entry can be configured for one of two types of initiating a transaction: Polled and Triggered. Polled type entries initiate a
transaction with the remote device on every transaction scan. Triggered type entries only initiate a transaction when a
corresponding local (OCS ) binary trigger register is set. Once a triggered type transaction completes, the protocol device driver
resets the local (OCS ) binary register to indicate completion.

These basic types are also subdivided into read or write operations. For polled operations, a Read operation only reads from a
remote device. Likewise a Read/Write operation continuously reads from the remote device unless the target OCS register value
changes from one ladder scan to another. In this case, the new OCS value is written to the target device. For triggered
operations, only a read or write action is available.
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When downloaded to the OCS , the Scan List is scanned sequentially to generate data transactions with the remote device. This
transaction scanning can be on a continual basis (automatic) or controlled from ladder logic (manual) once a complex
connection is created via a program. The specific transaction-scanning mode is selected from the Network Configmenu.

Refer to the Cscape Help file for more information on Downloadable Protocols Configuration.

13.2: Protocol Device Driver Selection
From the Cscape Home > Protocolsmenu, select the port drop-down box to select a protocol device driver. All protocol device
drivers currently loaded in Cscape are displayed in the drop down selection along with their version numbers. A selected
protocol can be removed by selecting None from the drop-down selection. Some OCSmodels can be limited in the number of
ports or number of protocol device drivers that can be selected. Once a protocol is selected, the Network, Devices and Data
(Scan List) must be configured through corresponding dialogues accessible through the respective buttons (Network, Devices
and Scan List).

NOTE: If the MJ1 port is to be used in the Protocol Config, it will no longer be available for Cscape programming unless the
controller is put into IDLE mode.

Three fields must be configured after a protocol is selected:
1. Network
2. Devices
3. Scan List
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13.3: Network Configuration

Network Configuration provides the required parameters to configure the network. Each protocol is different and may not require
the entire Network Config field. Refer to the table below for the options in the Network Config field.

Network Protocols
Baud Rate, Data
Bits, Stop Bits,

Parity
These field define the bit level transfer over the serial port.

Handshake

None – No handshake lines are used
Multidrop Full – Rx remains active while Tx is occurring.
Multidrop Half – Rx is shut off while Tx is occurring.
Radio Modem –Wait for CTS acknowledgment before transmitting (legacy radio modem support).

Protocol If a driver supports multiple protocols, it is selected here, (i.e., Modbus-TCP/UDP supports RTU or
ANSI).

Mode Specifies if port operates in RS-232 or RS-485 mode.

Retries Specifies number of times a transaction is retried on a failed response.

Timeout Specifies the amount of time for a device to wait for a valid response.

Update Scan
Automatic

Update Interval – Specifies the update interval at which all the mapped
entries are executed.

Reacquire Time – Specifies the amount of time to wait before attempting
communications with an offline device.

Manual Trigger – Specifies the binary register that a single transaction scan of the
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Network Protocols
Scan List.

ID Select – If an analog is specified in the field, the ID Select filter is
enabled.

Status Register Specifies the starting OCS register of eight (8) consecutive registers (4-32bit counters), which provide
an indication of the network health.

Scanner Address Specifies the OCS’s device (network) ID if a master ID is required by the protocol.

Protocol Help Provides protocol specific help.

13.4: Device List and Device Configuration
13.4.1: Device List

This configuration list is reached from the Device button on the Protocol Config screen and provides a list of the configured
devices on the Network. Devices must be created and exist in this list before corresponding Scan List entries can be created for
this device. Typically, the number of entries is limited to 64 devices.

l Add - Opens the Device Config dialog to add a new device to the list.
l Delete - Remove selected device from list (all corresponding Scan List entries are also removed).
l Config - Invoke the Device Config dialog for the currently selected device. This can also be accomplished by double-

clicking a device entry.
l Mapping - Invoke the Scan List limiting the entries displayed for the selected device.
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13.4.2: Device Configuration

This configuration is reached from the device list when adding or modifying an existing device. While each protocol is somewhat
different and can contain protocol specific field, all protocols typically support at least:

l Device Name - Specifies a tag name for this device. This tag name is used in the Data Mapping configuration to
identify this device. This allows device addresses to be modified without the need to update all associated Data
Mapping entries.

l Device ID - Specifies the target device communications ID or station address.
l Swap Words on 32-bit Data - If a Scan List entry is configured to transfer 32-bits and this option is checked, the high

and low 16-bit values are swapped when transferred between the target and OCS.
l Disable Device - From Cscape 9.90 SP3 and firmware 15.40 onwards, disable device feature has been added in

protocol device configuration. This option is used to disable a particular slave configured in the network. Single bit
register has to be configured to use this function. Setting the bit high disables the slave and OCS will not send any
serial (TCP for EtherNet/IP protocols) packets only to this slave until the bit is high. Setting the bit low enables the
communication with the slave again.

l Status Enable - This checkbox enables device status to be displayed and controlled from two consecutive 16-bit
registers.

l Status Address - Enter the starting 16-bit OCS register of two consecutive registers used for device status. The first
register contains the protocol device driver specific error code while the second register contains the index of the
offending Scan List entry.

l Status Modes: 
a. Stop on Error - Specifies that communications be only reattempted after offline status when the

corresponding device status register is cleared.
b. Retry on Error - Specifies that communications be reattempted either during the reacquire interval or when

the corresponding device status register is cleared.
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13.5: Scan List

This configuration list is reached from the Scan List button on the Protocol Config screen or theMapping button on the Device
List screen and provides a Scan List of the Data Mapping entries. To transfer data between the OCS and remote target, a Scan
List must be created that defines each transaction. Each mapping entry (transaction) contains the source and destination
registers, the number of consecutive registers transferred, the direction of the transfer and what triggers the transfer. Typically,
the number of entries is limited to 512.

NOTE: The order of the Scan List is the order in which the transactions occur. Sort functions are provided to change
the order of the list. Each entry also has an identifying index. If the device status register is enabled and a transaction failure
occurs, the status register indicates the index number of the transaction that failed.

13.5.1: Menu
l Edit > Copy All - Copies Scan List to clipboard in a tab delimited format suitable for pasting into an application like

Microsoft Excel.
l Edit > Paste - Loads Scan List from clipboard. Pasted items are added to the scan list even if they are duplicates.
l View > Toggle All Name View - Expands Scan List such that each point and corresponding local name is displayed.
l Sort Scan List by different criteria. The firmware will scan the devices based on the order they are displayed or sorted.

There are four ways to sort the scan list:
a. By Local Address – Sorts the list by local register address in increasing order.
b. By Target Address – Sorts the list by target register address in increasing order.
c. By Device Name – Sorts by device name, then target address.
d. Interleave Devices – This sort evenly distributes request among the different devices. Instead of requesting

100 blocks from device A, then 100 blocks from device B, one requests is sent to device A, then one request
is sent to device B until all the data has been requested. This is useful for devices that may have a timeout
timer because the time between each scan for a particular device is minimized. This sorting options usually
doesn’t affect performance.
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13.5.2: Buttons
l Add - Opens the Data Mapping dialog to add a new entry to the Scan List.
l Delete - Removes selected entry from Scan List
l Config - Opens the Data Mapping dialog for the currently selected entry. This can also be accomplished by double-

clicking an entry.
l Edit Names - Invokes the Edit Names dialog for the currently selected entry. The Edit Names dialog provides the

ability to create OCS program names for each point in the transaction.

13.5.3: Display Control
Filter by Device - Limits displayed entries to only those assigned to the indicated device. To show all entries select –All--.

13.5.4: Data Mapping Configuration (Scan List Entry)

Target

l Device Name - Selects the target device (by tag name) to use for this transaction. Only those device entries previously
created from the Device Config menu are available.

l Device Register - Specifies the target device’s register to use for this transaction. This designation is target-specific.
The configuration menu displays an error if a specified address is unacceptable.Generally, the data type of the
local (OCS ) register must match the data type of the device register.

l The Right Arrow button - Displays protocol device driver specific help for the target addressing. Note that some
devices can require register addresses that exist on 8-bit, 16-bit or 32-bit boundaries.

l Local Register - Specifies the local (OCS ) register that is the source or destination for the transaction.
l Local Name [Optional] - Optionally allows selection of a OCS register by name <or> creation of a name for a register

already selected by direct reference. Created names can be used thereafter to specify the local (OCS ) register in
ladder or graphics address fields.

l 32-Bit Access - Allows two local (OCS ) 16-bit registers to be treated as a single 32-bit value. For example, if the value
in either 16-bit register is modified, both registers are written to the device. Device-specific, 32-bit word swapping
options also apply to this designation. Since the transaction is treated as a 32-bit access, the length is generally limited
to 16. Note that some protocols can disable this feature.
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l Length
a. Specifies the number of consecutive device registers that are transferred in this transaction. Note that some

protocols can limit the length that can be transferred. However, typically the length is limited to 32. The
configuration menu displays an error if a specified length is unacceptable.

b. If allowed, specifying a length greater than one (multiple consecutive register transfers per
transaction) is more efficient than creating a single transaction for each register. This grouping of
registers per transaction can significantly reduce the transaction scan time; however, update types that
include writing on a polled basis require additional consideration.

c. On Read/Write and Read/Write/Init update types, the write transaction only occurs when the local (OCS )
register value changes. If the length is greater than 1 for Read/Write and Read/Write/Init types, only the local
register(s) that change in value are written. More specifically, only one write transaction occurs per scan per
mapping entry for the register or consecutive sub-group of local registers that changed in value. Depending
on the protocol, the number of points written with that write transaction are limited either to one or the number
of consecutive points that changed value.

d. Therefore, if several local registers (specified in a single mapping entry) change in value prior to a
transaction scan, it takes SEVERAL transaction scans to complete all the write operations.
Furthermore, all write operations are completed before a read operation is scheduled.

e. For Manual Update (transaction) scans (i.e. dialup modem), it is recommended that all Read/Write
Scan List entry lengths be limited to 1.

Update Type

This field specifies the direction and what triggers the transfer of data between the OCS and target device for a mapping entry.
l Polled Read - On every transaction scan, a read-only target device register(s) transaction occurs.
l Polled Read/Write

a. On every transaction scan, a read target device register transaction occurs unless a local register value has
changed. The write transaction only updates those local registers that have changed in value. If several non-
consecutive local registers (contained in a single mapping entry) change value between transaction scans, it
takes several consecutive transaction scans to write each changed register.

b. When the OCS is placed in RUNmode, the initial action for this mapping type is a read target register
transaction. This transaction initializes the local (OCS ) register(s) to match that of the remote device
register(s). Thereafter, any change to the corresponding OCS register(s) triggers a write operation to the
remote device.

l Polled Read/Write/Init
a. On every transaction scan, a read target device register transaction occurs unless a local register value has

changed. The write transaction only updates those local registers that have changed in value. If several non-
consecutive local registers (contained in a single mapping entry) change value between transaction scans, it
takes several consecutive scans to write each changed register.

b. On every transaction scan, a read target device register transaction occurs unless a local register value has
changed. The write transaction only updates those local registers that have changed in value. If several non-
consecutive local registers (contained in a single mapping entry) change value between transaction scans, it
takes several consecutive scans to write each changed register.

c. When the OCS is placed in RUNmode, the initial action for this mapping type is a write target register
transaction. This transaction initializes the target device register(s) to match that of the local (OCS ) register
(s). Thereafter, any change to the corresponding OCS register(s) triggers a write operation to the remote
device.

d. The initial write transaction does not occur until after the first logic scan of the OCS . This allows registers to
be initialized locally before Writing to the target device register(s).

l Triggered Read - A read transaction is triggered by a high level on a separately designated OCS (binary) trigger
register. Once the read transaction is complete (or the device is offline), the OCS trigger register is cleared by the OCS
. This update type can be used for occasional data accesses such as retrieving trend data. Note that this operation
increases the associated transaction scan time and can cause the Update Interval Exceeded Counter to increment
on a tightly adjusted update interval.
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l Triggered Write - A write transaction is triggered by a high level on a separately designated OCS (binary) trigger
register. Once the write transaction is complete (or the device is offline) the OCS trigger register is cleared by OCS .
This function can be used for occasional data accesses such as sending recipe data. Note that this operation increases
the associated transaction scan time and can cause the Update Interval Time Exceeded Counter to increment on a
tightly adjusted update interval.
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All Horner controllers models provide a Removable Media slot, which supports standard microSD flash memory cards. microSD
cards can be used to save and load applications,and to log data for later retrieval.

14.1: microSD Cards
MicroSD cards (Memory Cards) with up to 32GB of flash memory, are compatible with the Horner controller Memory Card slot.
A microSD card can be safely inserted into the Memory Card slot whether the Horner controller power is On or Off.

Installing the microSD Card
To Install a microSD card: align the gold edge connector toward the switch and carefully push it all the way into the slot. To
remove, gently pull up on the card.

14.1.1: microSD File System
The microSD Memory Card slot uses the PC-compatible FAT32 File System. This means that a PC, with a microSD-compatible
card reader, can read files that have been written by the Horner controller and can write files that can be read by the Horner
controller.
However, the Horner controller does not support long filenames, but instead implements the 8.3 filename format. This means
that all file and directory names must consist of up to eight (8) characters, followed by an optional dot, and an optional extension
with up to three (3) characters.
Directories and sub-directories can be nested up to 16 levels deep as long as each path name string does not exceed 147
characters.
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14.2: Log Data
Using Read andWrite Removable Media function blocks, an application ladder program can read and write Horner controller
register data in the form of comma-delimited files, with a .csv extension. These files are compatible with standard database and
spreadsheet PC programs. In addition, an application ladder program can use Rename and Delete Removable Media function
blocks to rename and delete files.

14.3: Loading Program from microSD Card Using Switch
Use the following steps to load a program frommicroSD card:

1. Copy the .PGM file from Cscape using the Export To PGM option.

2. Select the correct Firmware Export Version.

3. Rename the file to DEFAULT.PGM.

4. Copy DEFAULT.PGM to root of a MicroSD Card.
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14.4: Clear Application Using the Switch
To clear an application, do the following:

1. Hold the switch in LOAD position for 10 seconds, then release it. The MS LED will blink RED indicating that the device
is ready to clear the application.

2. While the MS LED is still blinking RED, turn the switch to LOAD position again and hold it for 10 more seconds. At the
end of the 10 seconds the MS LED will stop blinking

3. Turn the switch to the STOP position, when the switch is released to the STOP position, the device will start clearing
the application and restart itself.

If the MS LED is blinking RED and the switch is not turned to the LOAD position for second time, it will blink for 30 seconds, turn
off, and the application will not be cleared.

14.5: Function Blocks in Cscape

NOTE: For detailed information regarding RM function blocks and parameters, refer to the Help File in Cscape Software.
Refer to ‘USB flash Media support for RM Functions’ for USB flash drive access details.

The following RM functional blocks are available in Cscape Software. These function blocks will reference:
a. microSD when filename is prefixed with ‘A:’ or nothing
b. USB A flash drive when filename is prefixed with ‘B:’

Read RM csv Allows reading of a comma-separated value file from the microSD interface into the controller
register space.

Write RM csv Allows writing of a comma-separated value file to the microSD interface from the controller
register space.

Rename RM csv Allows renaming a file on the RM card. The data in the file is not changed.

Delete RM csv Allows deleting a file on the RM card

Copy RM csv Allows copying a file on the RM card. The data in the file is not changed.

14.5.1: Program Features
a. Datalog Configuration - This feature allows the controller to periodically log register values to Removable Media. The

register data is stored in .csv (comma separated value) format, which is compatible with 3rd party PC applications,
such as Microsoft Excel.

b. Report Editor - This feature allows the OCS to be configured to generate text printouts which incorporate data from
the registers embedded in the text. The reports can be printed using a serial interface printer through any of the serial
ports of the OCS or can be saved on the removable media of the device.

c. Recipes Editor - Recipes allow the user to send or update multiple registers simultaneously.
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14.6: Filenames
The RM function blocks support the flash with a Windows standard FAT-16 file system. All names must be limited to the “8.3”
format where the filename contains eight characters a period then a three-character extension.
The entire filename including any path must be less than or equal to 147 characters.
When creating filenames and directories, it is sometimes desirable to include parts of the current date or time. There are six
special symbols that can be entered into a filename that are replaced by the OCS with current time and date information.

Filename Special Symbols
Symbol Description Example

$Y Substitutes the current 2-digit year 2015 = 15

$M Substitutes the current month with a 2-digit code March = 03

$D Substitutes the current day 22nd = 22

$h Substitutes the current hour in 24-hour format 5 pm = 17

$m Substitutes the current minute 45 = 45

$s Substitutes the current second 34 = 34

NOTE: All the symbols start with the dollar sign ($) character. Date symbols are in upper case, time symbols are in lower
case.

The following are examples of the substituted time/date filenames:
Current date and time: March 1, 2015 5:45:34 PM
Filename: Data$M$D.csv = Data0301.csv
Filename: Year$Y\Month$M\aa$D_$h.csv = Year15\Month03\aa01_17.csv
Filename: Month_$M\Day_$D\$h_$m_$s.csv = Month_03\Day_01\17_45_34.csv

14.7: System Registers and Removable Media
%SR174 – Removable Media Protect. Write a one (1) to %SR174 to prohibit read/write access to the removable media card.
Write a zero (0) to allow access.
%SR175 Status – This shows the current status of the RM interface.
%SR176 Free Space – This 32-bit register shows the free space on the RM card in bytes.
%SR178 Card Capacity – This 32-bit register shows the total card capacity in kilobytes.
Possible status values are shown in the table:

RM Status Values
0 RM interface OK

1 Card present but unknown format

2 No card in slot

3 Card present, but not supported

4 Card swapped before operation was complete

5 Unknown error
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"Clone Unit" feature allows the user to “clone” the OCS of the exact same model. This feature “clones” application program and
unit settings stored in the following:

l Prime Series: retentive memory

l Non-Prime controllers: battery-backed RAMregister/variable memory of an OCS into the RM

This feature can be used for:
l Replacing an OCS by another unit of the same model.
l Duplicating or “clone” units without a PC.

15.1: Make Clone
Make/Create clone can be triggered by setting %SR164.9 bit to “1” from the Ladder program or graphics. When the operation is
completed, this bit is made zero by the firmware. When the Make Clone operation is triggered by this SR bit, it does not ask the
user for confirmation for making clone.
In case of failure, %SR164.11 bit is set to “1” by the firmware and never reset.

NOTE: Backup of registers in flash memory is not performed by Clone Feature. Refer to "Fail-Safe System" on page 81.

15.2: Load Clone
Load Clone can also be triggered by setting %SR164.10 bit to “1” from the Ladder program. When the operation is completed,
this bit is made zero by the firmware. When the Load Clone operation is triggered by this SR bit, it does not ask the user for
confirmation for loading clone.
In case of failure, %SR164.12 bit is set to “1” by the firmware and never reset.
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16.1: Fail-Safe Features

16.2: Fail-Safe System Overview
The Fail-Safe System has the following capabilities:

l Manually backup the current retentive register settings into flash memory.
l Manually restore register settings from the values previously backed up in flash memory to retentive registers.
l Detect corrupted register settings at power-up and then automatically restore them from flash.
l Detect corrupted or empty application in flash memory at power-up and then automatically load the AUTOLOAD.PGM

application file from Removable Media (Compact flash or microSD).
l If an automatic Register Restore or Application Load occurs, the OCS can automatically be placed in RUNmode.
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16.3: Settings
To use the Fail-Safe feature, the following steps are required:

1. From Cscape, create AUTOLOAD.PGM for the application program using Export to Removable Media.
2. Place the Removable Media with AUTOLOAD.PGM in the device.
3. Set the Enable AutoLoad option by setting HIGH%SF164.6.
4. Enable the AUTORUN option by making High %SR164.5. if the controller needs to be placed in RUNmode

automatically after automatic restore of data or AutoLoad operation.
5. Backup the current primary memory register contents in the onboard flash memory.

16.3.1: Backup OCS Data
When initiated, the user can manually copy register contents onto the an alternate section of onboard flash memory of the OCS.
This will have result in backing up all the registers and controller settings (Network ID, etc.) that would otherwise be lost due to a
memory failure. %SR164.4 is set to 1 when backup operation is performed.

16.3.2: Restore OCS Data

Automatic Restore Operation

When initiated, the user can copy the backed-up data from the onboard flash to the battery-backed RAM.

A restore operation is automatically initiated if 1) a backup has been previously created and 2) on power-up the battery-backed
RAM registers fail their check.

The following process will be followed for restoring data:
l The controller will be placed in IDLE mode.

l Data will be copied from onboard flash memory to OCS battery-backed RAM •

l The controller will reset.

l The controller will be put in RUNmode if the AutoRun setting is ‘Yes’, or else it will remain in IDLE mode.

%SR164.3 is set to 1 when an automatic restore operation is performed. This bit is reset to the value of “0” when a new backup is
created.

Manual Restore Operation

l Restoring of data can be manually performed by setting %SR164.14 to 1, this in turn sets %SR164.15 to 1.

l The user needs to set %SR164.15 to 0 complete the restore operation or set %SR164.14 to 0 to abort

%SR164.3 is set to 1 only when an automatic restore operation is performed, not on a manual one. This bit is reset to the value
of “0” when a new backup is created.

16.4: Clear Backup Data
When initiated, the backup data will be erased from the onboard flash and no backup will exist. %SR164.4 and %SR164.3 are
reset to 0 when backed-up data is erased.
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The OCS follows the following sequence in execution of Automatic Restore:
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16.5: AutoLoad
This option allows the user to specify whether the OCS automatically loads the application AUTOLOAD.PGM located in
Removable Media.
When the AutoLoad setting is enabled (%SR164.6=1), it can be automatically initiated at power-up.
The automatic initiation will happen only in the following two cases:

l When there is no application program in the OCS and a valid AUTOLOAD.PGM is available in the removable media of
the device.

l When the program residing in onboard memory is corrupted and a valid AUTOLOAD.PGM is available in the
removable media of the device.

When the AutoLoad setting is not enabled (%SR164.6=0), OCS will be in IDLE mode and the application is not loaded.
%SR164.6 can be set to enable AutoLoad feature.
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The OCS follows the following sequence in execution of AutoLoad:
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16.6: AutoRun
This option, when enabled (%SR164.5=1), allows the user to automatically place the OCS into RUNmode after the AutoLoad
operation or automatic Restore Data operation. When the AutoRun setting is disabled (NO), the OCS remains in the IDLE mode
after a Restore Data or AutoLoad operation. %SR164.5 can be set for putting the system into RUNmode automatically, once an
AutoLoad has been performed or an Automatic Restore has occurred.
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For complete Modbus instructions, see the Help file in Cscape.
Modbus (serial) is a popular, de-facto standard protocol that allows industrial devices frommultiple manufacturers to easily
share data in real-time. For Modbus serial communications, the OCS controller can act as either a Master or a Slave.
Modbus protocol (serial) allows for one master and multiple slaves. The master always initiates the conversation by sending a
request to a particular slave. Only the addressed slave will send a response when the request is completed. Should the slave be
unable to complete the request, it returns the appropriate error response. Should the slave be unable to respond, the master’s
timeout timer expires to provide an indication of No Response.

17.1: Modbus Slave Overview
The Modbus slave function block, when used with the appropriate Modem and/or Open Function Blocks, allows the primary
serial port on the controller to act as a Modbus slave. The Modbus function supports both ASCII and RTUmodes of operation
across a range of baud rates and protocol frames. Also supported is port activity status, an inactivity timer, support for call-on
exception, and support for store and forward (repeater) operation for radio modems.
The Modbus Addressing section describes the supported Modbus Commands as well as the Modbus Map for OCS controller
references (%R, %M, etc.).

17.2: Modbus Master Overview
For complete Modbus Master instructions, please refer to the Help file in Cscape.
When acting as a Modbus master, there are two primary mechanisms used by the OCS controller to allow the user to specify the
data to be read/written from/to the slaves.
Modbus Master Function Block—This is for serial only. This is an advanced feature that should only be used in rare
occasions.
Protocol Config—The Protocol Config is configured in the Hardware Configuration dialog box in Cscape (serial). Refer to the
Modbus Addressing section. This is the preferred method in most applications.
After the protocol has been selected from the dropdown menu, the Network, Devices, and Scan List become available. The
Protocol Config is configured on three different levels:

n Network—Parameters, such as the polling rate of the data scan, are specified along with timeout values, retry, and re-
acquisition settings. Serial configuration, baud rate, parity, etc. are also set here.

n Devices—For every slave to be polled, configuration details are added in the Devices dialog box. This includes Slave
ID (serial). Under Device Type, the Modbus addressing style matching that specified in the slave’s user documentation
may be selected. For instance, some slaves specify Modbus addresses (i.e. 40,001), and others specify offsets (i.e.
0000).

n Hex or Decimal—Some specify addresses in hex, and others in decimal. By allowing the user to select the
Modbus addressing style for each slave on the network, minimal address conversion is required. Also, if the
slave is another Horner product (i.e. another OCS), the “Native Addressing” option can be selected (i.e. %R1,
%M17, etc.), and this skips the conversion to Modbus style altogether.

n Scan List—This is where the specific Modbus addresses to be read/written from/to each slave are specified. Up to 32
words of data can be read at the same time.
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17.3: Modbus Addressing Table
To access the registers, a Modbus Master must be configured with the appropriate register type and offset. This is usually
accomplished with one of two methods:
Method 1: The first method uses Traditional Modbus References, in which the high digit represents the register type, and the
lower digits represent the register offset (starting with Register 1 for each type). Since only four register types can be
represented in this manner, OCS controller Modbus Function Blocks pack several register types into each Modbus register type.
Starting addresses of each register type are shown in the Traditional Modbus Reference column of the Mobus Table.
Method 2: The second method requires the Modbus Master to be configured with a specific Modbus Command and Modbus
Offset. The supported Modbus commands and the associated offsets are also illustrated in Modbus Table.

OCS Controller Modbus Master Mapping

Reference Maximum
Range

Trad. Modbus Reference (5
Digits)

Expanded Modbus Ref. (6
Digits)

Modbus Command
(s)

Modbus
Offset

%I1 1024 10001 010001

Read Input Status (2)

0

%IG1 256 13001 013001 3000

%S1 256 14001 014001 4000

%K1 10 15001 015001 5000

%Q1 1024 00001 000001
Read Coil Status (1)

Force Coil (5)
Force Multiple Coils

(15)

0

%M1 1024 03001 003001 3000

%T1 1024 06001 006001 6000

%QG1 256 09001 009001 9000

%AI1 256 30001 030001
Read Input Register

(4)

0

%AIG1 32 33001 033001 3000

%SR1 200 34001 034001 4000

%AQ1 256 40001 040001
Read Holding
Register (3)

Load Register (6)
Load Multiple
Registers (16)

0

%R1 2488 40513 040513 512

%R1 2048 43001 043001 3000

%AQG1 32 46001 046001 6000

%R1 5000 -- 410001 10000
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Chapter 18: Firmware Updates

NOTE: For information on how to update firmware for the CPU200/250, see MAN1521 on the Document Search page.

The OCS products contain field updatable firmware to allow new features to be added to the product. Firmware updates should
only be performed when a new feature or correction is required.

WARNING: Firmware updates should only be performed when the equipment being controlled by the OCS is in a safe, non-
operational state. Communication or hardware failures during the firmware update process can cause the controller to
behave erratically resulting in injury or equipment damage. Make sure the functions of the equipment work properly after a
firmware update before returning the device to an operational mode.
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19.1: Low or Missing Battery 93
19.1.1: Lost Program 93

19.2: Steps to Replace the Battery 93
The OCS controller contains a run-time battery monitor that checks the voltage of the internal lithium battery. This battery is used
to run the real-time clock and maintains retentive registers when power is disconnected.
The battery will generally last seven (7) to ten (10) years. Environmental conditions, including extreme temperatures and
humidity, can affect battery life. If the battery older than seven (7) to ten (10) years old, it is recommended that it be replaced as
preventative maintenance.

WARNING: DO NOT USE IF BATTERY IS LEAKING OR HAS BEEN DAMAGED.

WARNING: LITHIUM BATTERIES MAY EXPLODE OR CATCH FIRE IF MISTREATED.

WARNING: DO NOT RECHARGE, DISASSEMBLE, HEAT ABOVE 100° C (212° F) INCINERATE, OR PUNCTURE.

WARNING: EXPLOSION HAZARD – BATTERIES MUST BE ONLY BE CHANGED IN A AREA KNOWN TO BE NON-
HAZARDOUS.

WARNING: Disposal of lithium batteries must be done in accordance with federal, state, and local regulations. Be sure to
consult with the appropriate regulatory agencies before disposing batteries. In addition, do not recharge, disassemble, heat
or incinerate lithium batteries.

WARNING: Do not make substitutions for the battery. Be sure to only use the authorized part number to replace the battery.

The OCS controller uses a 3V lithium coin battery which can be ordered from Horner APG, part number
HE-BAT009.

19.1: Low or Missing Battery
If the battery voltage is low or if the battery is lost, the program will be completely erased at power down. There will be an
error message on bootup stating that the battery is low or missing. The following will also occur.

l %SR55.13 bit will be High if battery is low or lost
l Device date and time will set to default values 01-01-1996 ,12am. This will need to be set again once the battery is

replaced.

19.1.1: Lost Program
If the user has created a backup, then the program, along with the register data, will be saved in the internal memory and can be
auto-restored.
To create a backup, see "Fail-Safe System" on page 1.

19.2: Steps to Replace the Battery
1. Make sure the user program and any data stored in retentive memory is backed up.
2. Disconnect all power from the OCS unit including I/O power.
3. Remove all connectors, and then use a flat head screwdriver to press and release the four (4) clips. Remove the back

cover.
4. Remove the old battery. It may require a small flat blade screwdriver to lift it from the holder.
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5. Dispose of the battery properly; refer to the above warning on disposal regulations.
6. Slide the new battery into the holder. Make sure the battery is inserted with the proper polarity. The top tab of the

battery holder should contact the positive (+) terminal of the battery.
7. Place the back cover over the unit and gently press each corner evenly in order to snap the clips back into place.
8. Apply power to the unit. Check that the battery error is no longer reported. If the unit still reports the error, remove the

battery immediately and contact "Troubleshooting" on page 96.
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20.4: Basic Removable Media Troubleshooting 99
20.5: Technical Support Contacts 99

20.1: Connecting to the OCS
Cscape connects to the local controller automatically when the serial connection is made. The status bar below shows an
example of a successful connection. This status bar is located in the bottom right-hand corner of the Cscape window.

In general, the Target number should match the Local number. The exception to this is when the controller is being used as a
"pass through" unit where other controllers on a CsCAN network could be accessed through the local controller. See Cscape
Help File for more details.

Determine connection status by examining feedback next to Local & Target in the status bar of Cscape.

Cscape Target & Local Numbers
Local: ### If a number shows next to Local then communication is established to the local controller.

Local: No Port
Cscape is unable to access the COM port of the PC. This could mean that Cscape is configured for a
COM port that is not present or that another program has control of the COM port. Only one Cscape
window can access a port at a time. Subsequent instances of Cscape opened will indicate No Port.

Local: No Com Cscape has accessed a PC COM port but is not communicating with the controller. This typically occurs
when the controller is not physically connected.

Local: ??? Unknown communication error. Close Cscape, power cycle the controller and reopen Cscape with a
blank project. Check Local.

Target: #(I,R,D) If I (idle), R (run), or D (do I/O) shows next to Target number, then communication is established to the
target controller.

Target: #(?) Communication is not established to the target controller. Check node ID of controller and set Target to
match. Make sure local connection is established.

20.1.1: Serial Port – MJ1 Programming
1. Controller must be powered up.
2. Ensure that the correct COM port is selected in Cscape. Tools > Applications Settings > Communications.
3. Ensure that a cable with proper pinout is being used between PC and controller port MJ1.
4. Check that a Loaded Protocol or ladder is not actively using MJ1. Taking the controller out of Run Mode will make MJ1

available to Cscape.
5. Successful communications with USB-to-serial adapters vary. If in doubt, Horner APG offers a USB to serial adapter:

part number HE-CPK.
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20.1.2: USB Port Programming
1. Power-up the controller.
2. Ensure that the correct COM port is selected in Cscape.Tools > Applications Settings > Communications >

Configure
3. Confirm that the USB cable is connected between the PC and the controller.
4. Examine the Windows Device Manager to confirm that the USB driver is correctly installed and to verify the port

number.
5. The USB port driver installs.

20.1.3: ETN Port Programming
1. Controller must be powered up.
2. Ensure that the correct IP address is given in the Ethernet field and correct Mode is selected, in Cscape: Tools >

Applications Settings > Communications > ConfigureHome tab / Controller Group > Connection Wizard.
3. Ensure that an Ethernet connection has been established by pinging the controller from the Windows DOS prompt.
4. The PC and the OCS should be on the same IP subnet.

20.2: Local Controller and Local I/O
20.2.1: Local I/O Troubleshooting Checklist

1. Verify the controller is in RUNmode.
2. Check diagnostics to ensure controller passed self-tests. View Diags in Cscape, click Controller/Diagnostics.
3. Check data sheets to ensure proper wiring.
4. Ensure that hardware jumpers and software configuration for I/O match.
5. Check data sheets for voltage and current limits.
6. Take ladder out of the picture. From Cscape set controller to “Do I/O” mode. In this mode inputs can be monitored, and

outputs set from a data watch window in Cscape without interference from the ladder program. Some I/O problems are
only a result of a mistake in the ladder program.

WARNING: Setting outputs ON in Do I/O mode can result in injury or cause machinery to engage in an unsafe manner
depending on the application and the environment.

20.3: CsCAN Network
For complete information on setting up a CsCAN network, refer to CAN Networks manual (MAN0799) by using Horner's
Documentation Search page.
Network status, node ID, errors, and baud rate in the controller SystemMenu are all in reference to the CsCAN network. These
indications can provide performance feedback on the CsCAN network and can also be used to aid in troubleshooting.
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20.3.1: CsCAN Network Troubleshooting Checklist
1. Use the proper Belden wire type or equivalent for the network as specified in the CAN Networks Manual, MAN0799.
2. The Horner OCS does not provide 24VDC to the network. An external voltage source must be used for other devices

such as SmartStix I/O.
3. Check voltage at both ends of the network to ensure that voltage meets specifications of attached devices.
4. Proper termination is required. Use 121Ω (or 120Ω) resistors at each end of the network. The resistors should be

placed across the CAN_HI and CAN_LO terminals.
5. Measure the resistance between CAN_HI and CAN_LO. If the network is properly wired and terminated, there should

be around 60Ω.
6. Check for duplicate node ID’s.
7. Keep proper wires together. One twisted pair is for V+ and V- and the other twisted pair is used for CAN_HI and CAN_

LO.
8. Make sure the baud rate is the same for all controllers on the network.
9. Assure shields are connected at one end of each segment—they are not continuous through the network.
10. Do not exceed the maximum length determined by the baud rate and cable type.
11. Total drop length for each drop should not exceed 6m (20’). A drop may include more than one node. The drop length

adds to the overall network length.
12. Network should be wired in "straight line" fashion, not in a "star" pattern.
13. In applications requiring multiple power supplies, make sure the V- of all supplies is connected and to earth ground at

one place only.
14. In some electrically noisy environments, it may be necessary to add repeaters to the network. Repeaters can be used

to add additional nodes and/or distance to the network and protect the signal against noisy environments.
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20.4: Basic Removable Media Troubleshooting
Description Action

OCS does not read media card. Attempt reformatting the media card.

OCS will not download a program
file from removable media.

When downloading to the OCS from removable media the program file must have a
.pgm extension. A program file with the typical .csp extension will not work. A .pgm file is
created either by exporting to .pgm in Cscape or by doing a save program or make clone
from an OCS controller.

The filename must follow the short filename convention which is an 8.3 format; For
example, program.pgm is a valid filename. Programming.pgm is not a valid filename as
characters left of the point exceed the maximum of 8 characters.

20.5: Technical Support Contacts
For manual updates and assistance, contact Technical Support at the following locations:

North America:
Tel: (317) 916-4274
Fax: (317) 639-4279
Website: https://hornerautomation.com
Email: APGUSATechSupport@heapg.com

Europe:
Tel: (+) 353-21-4321-266
Fax: (+353)-21-4321826
Website: https://www.hornerautomation.eu
Email: technical.support@horner-apg.com
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